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Chapter 1: Getting Started
Welcome to StuffIt Deluxe 8.0! For general information about StuffIt 
Deluxe, including System Requirements, Installation instructions, and a list 
of new features, please read the StuffIt Deluxe Quick Start Guide.

StuffIt Deluxe now includes HTML based AppleHelp for many of its 
components. AppleHelp is available for StuffIt Expander, DropStuff, 
DropZip, DropTar, and Archive Assistant. You can access AppleHelp, 
while running the applications, by clicking the Help menu.

This chapter is designed to provide information for new users. If you've 
never used StuffIt Deluxe before, this chapter will tell you everything you 
need to know about expanding the files you download from the Internet, 
compressing files to save space, and sending files to other people using E-
mail.

If you need help using StuffIt Deluxe, Aladdin’s online site provides a 
constantly updated system of FAQ's (Frequently Asked Questions). The 
chances are that someone else has already reported the same issue, and 
we've posted information about it. Our new and improved Support site 
offers an easy three-step process for finding all the FAQ's related to your 
version of the software Or if you prefer, use the new intuitive search 
engine, which allows you to search all the FAQ's and then search within 
your results, 

To visit Aladdin’s online support site, go to:   

http://www.aladdinsys.com/support/techsupport/index.php

The new Support site also offers a public forum where you can post your 
question and have it answered online by the Forum's resident experts and/
or Aladdin Support Specialists. Finally, if you still haven't found the 
answer? After reviewing the pertinent FAQ's, you can submit a form to our 
Support crew, which they will respond to by email. Support requests are 
answered in the order they are received and response time varies depending 
on the number of pending requests. Therefore we recommend checking the 
FAQ’s and using the public forum. 
Welcome!

Using the 
included 
documentation

What to do if you 
need Help
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When asking your question on the forum or submitting a Support request, 
you will need to know the following information:  

• The exact version of the product you are using. This can be 
found in the product About box (available in the Apple menu 
when your StuffIt product is in the foreground of your screen).   

• Your registration number if applicable.  
• The exact version of the Mac OS you are using. This can be 

found by choosing "About this Mac" from the Apple menu in 
the Finder on Mac OS X.    

All other inquiries should be directed to the following address:
   
Aladdin Systems, Inc. 245 Westridge Drive,  
Watsonville,  CA 95076, USA  
Tel.: 1+ (831) 761-6200  
Fax: 1+ (831) 761-6206  
Web: http://www.aladdinsys.com  

StuffIt Expander™ is used to expand the archived, 
compressed, or encoded documents you receive from 
others, over the network, on the Internet, or on a disk. When 
you download files from the Internet, you'll find that they 
are typically packaged in a StuffIt archive. Anytime you see 
a file with “.sit” at the end of the file name, you're dealing 

with a StuffIt archive that contains other files. The best way to understand 
what an archive is, and why they are used so often, is to imagine that a file 
posted on the Internet is just like an item you would send through the 
regular mail. Just as you take precautions when sending a vase through the 
mail, by carefully packaging it so that it won't get broken, so when you 
send files to people over the Internet you should protect the file against 
damage by placing it in a StuffIt archive. Plus, because putting a file in a 
StuffIt archive makes it smaller, the file takes less time to transfer.
StuffIt Expander 

: The Basics
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Expander is the application you use to open a .sit archive. The easiest way 
to use StuffIt Expander is to “Drag and Drop” the file you want to open, on 
top of the StuffIt Expander icon that was created on the desktop when you 
installed the product. When you drag and drop the file on top of StuffIt 
Expander, the application will launch, and expand the item inside the 
archive. By default, the item in the archive will be created in the same 
folder as the archive itself. For example, if you download a file from the 
Internet to your desktop, and then drag and drop that file on top of StuffIt 
Expander, the item inside the archive will also be placed on the desktop. If 
the archive you are expanding contains multiple items, they will be placed 
in a new folder that will be created in the same location as the archive you 
are expanding.

In addition to opening StuffIt Archives, you can use StuffIt Expander to 
open just about any compressed or encoded file you encounter on the 
Internet. Expander can open StuffIt, StuffIt X, Zip, and Tar archives, and 
BinHex, MacBinary, Mime, and UU encoded files, and many, many more. 
See “Supported Archive Formats” on page 95 in Chapter 17 for a list of all 
supported file formats.

In addition to expanding all the files in an archive, you can also choose to 
expand only the files you need. To expand individual files from a larger 
archive you would use the StuffIt Deluxe application. See “How do I 
Extract Files from an Archive?” on page 13 in Chapter 2 for more 
information
Chapter 1: Getting Started - 6
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DropStuff™ is the counter part to StuffIt Expander. Just as 
you use StuffIt Expander to open compressed and encoded 
files, so you use DropStuff to create archives from your 
files and folders. You can use DropStuff to create archives 
in StuffIt (.sit) and StuffIt X (.sitx) formats. 

Typically, you'll want to use DropStuff to compress your files whenever 
you're posting them on the Internet, or whenever you're making backup 
copies of your files. When you're sending files over the Internet, 
compressing files to make them smaller means that it will take you less 
time to upload the file, and it will also take the person receiving the file less 
time to download and open it. Anyone on any type of computer can open 
StuffIt archives, just point them to http://www.stuffit.com to download the 
FREE StuffIt Expander software they'll need.

DropStuff works exactly like StuffIt Expander (see above), except that it 
creates archives rather than expanding them. The easiest way to use 
DropStuff is to drag and drop the files you want to compress on to the 
DropStuff icon that was created on the Desktop during the installation. The 
files and folders you dragged onto the icon will be compressed into a new 
StuffIt archive. The archive will be created in the same location as the files 
and folders you dropped onto DropStuff. For example, if you drag a folder 
called “Pictures” from your documents folder onto DropStuff, you will find 
a new file call “Pictures.sit” in your documents folder. 

By default, DropStuff is configured with settings that are best for everyday 
use. DropStuff can be configured, however, to create archives for specific 
purposes. The two options you'll likely want to use most often are Self-
Extracting archives, and Encrypted archives.

Self-Extracting archives are special types of StuffIt archives that can be 
opened without StuffIt Expander. To open a self-extracting archive (.sea) 
simply double click the file. To create a self-extracting archive you'll need 
DropStuff:
The Basics
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to open the DropStuff preferences dialog. To do so, choose Preferences 
from the DropStuff menu in OSX, or Preferences from the Edit menu in 
Mac OS 8.6 - 9.2.2.

Check the “Make self-extracting” check-box to tell DropStuff to make self-
extracting archives, and use the toggle menu to specify the Operating 
System on which the SEA will be used. Because self-extracting archives 
use application code, they have to be made differently depending on the 
Operating System on which they will be used. DropStuff allows you to 
make self-extracting archives for the Mac OS and Windows. Self-
Extracting archives for Mac OS will be created with “.sea” at the end of the 
file name, and self-extracting archives for Windows will be created with 
“.exe” at the end of the file name.

Tip: Even though self-extracting archives for Windows (.exe) will 
only self-extract on a PC, they can be opened on a Mac. To open a 
Windows self-extracting archive on a Macintosh, drag and drop the 
file on the StuffIt Expander icon. This type of file can therefore be 
used when you’re not sure if the recipients are using a Mac or a PC.

When you are sending sensitive files to other people, you can use 
encryption to protect them with a password. This means that if someone 
other than your intended recipient receives the archive that the files are 
stored in, they will not be able to open it and gain access to your 
documents. To tell DropStuff to protect your archives with encryption, 
you'll need to open the Preferences dialog. To do so, choose Preferences 
from the DropStuff menu in OSX, or Preferences from the Edit menu in 
Classic version of the Mac OS.

Check the "Encrypt Archives with Password" check box (see above) to tell 
DropStuff to add a password to your archives when they are created. When 
you drag and drop files on DropStuff, you will be prompted to enter the 
password you would like to use.
DropStuff:
Self-Extracting 
Archives

DropStuff:
Encrypted 
Archives
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Warning: When you create an encrypted archive, be sure to make a 
careful note of the password that you used. Aladdin Systems is not 
able to recover the contents of an encrypted archive if the password 
has been lost. There is no “Back Door”.

The StuffIt Contextual Menu provides you with a way to access the power 
of StuffIt Deluxe without having to launch any of the StuffIt applications. It 
creates a special icon in the menu bar of the OS. To access the contextual 
menu, hold down the Control (Ctrl) key while clicking a file. After you 
install StuffIt Deluxe, you should see a new "StuffIt" Menu appear in the 
contextual menu. 

You can use the StuffIt Contextual Menu (or “CM”) to compress files into a 
new StuffIt archives, and you can also use StuffIt CM to make archives in 
other formats as well. To compress using the StuffIt contextual menu, hold 
down the Control (Ctrl) key, and click the file you want to compress. 
Choose “Stuff” from the StuffIt contextual menu to compress the selected 
file or folder into a StuffIt archive.

You can choose to 
compress files and 
folders using an archive 
format other than StuffIt, 
by using StuffIt CM’s 
“Archive” sub-menu. 
Under the Archive 
submenu you will be able 
to create Zip archives, 
Tar archives, and Lha 
archives. You will also 
see various options here 
that allow you to further 
encode an archive you 
have created.

You can also make self-
extracting archives from 
StuffIt contextual menu. 

Select the file or folder you want to make into a self-extracting archive and 
then choose either “Mac OS” or “Windows” from the “Make self-
extracting” sub-menu.
StuffIt             
Contextual 
Menu:
The Basics

Compressing with 
StuffIt CM
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The StuffIt Contextual Menu also allows you to encode files. Use encoding 
when you want to post files to a News Group, or when you want to send 
them via E-mail. You should also use encoding when you are posting a 
Macintosh file that contains a resource fork (such as a Macintosh 
application, or a self-extracting StuffIt archive) to a web site for other Mac 
users to download. Typically, when you send files via E-mail, or upload 
them to an FTP site for access over the Internet, you'll find that the 
application you use to post or E-mail will encode the files for you.

To Encode files using the StuffIt contextual menu, Control (Ctrl) click the 
file, and use the "StuffIt" menu to access the "Encode" sub menu.

Tip: You can only encode single files. If you need to post a folder 
full of files, and need to use encoding, first compress the folder into 
an archive, and then encode that archive. You can perform this task 
in a single step, for example, by choosing Stuff and BinHex from the 
Archive menu in the Magic Menu, or the StuffIt contextual menu.

To configure how the various options in the Magic Menu and the StuffIt 
context menu work, choose Preferences from the StuffIt Context menu. For 
more information about changing settings using Menu Preferences, see “” 
on page 77 in Chapter 12.

The Magic Menu and the Contextual Menu also allow you to access one of 
the most useful features of StuffIt Deluxe, Stuff and Mail. Stuff and Mail 
allows you to compress a file or folder into a StuffIt archive, and then 
automatically attach that folder to a new email message. To use Stuff and 
Mail, select the file or folder you want to send, and then choose "Stuff and 
Mail" from the Magic Menu. You can use the StuffIt contextual menu by 
Control (Ctrl) clicking the file, and choosing "Stuff and Mail" from the 
StuffIt menu.

By default, Stuff and Mail will use the Mail client that is currently set as 
the default on your system. For a new Macintosh, this will be Outlook 
Express for Mac OS Classic, and Mail for Mac OS X. You can, however, 
change the mail client that Stuff and Mail uses with the Menu Preferences 
application. Stuff and Mail supports Apple Mail, America Online, Claris 
Emailer, Entourage, Eudora, Mailsmith, Outlook, Outlook Express, 
Power- Mail, and QuickMail Pro. 

After choosing Stuff and Mail, all you need to do is type the recipients E-
mail address in the new message window, and click send.
Encoding with 
StuffIt CM

Setting Options

Stuff and Mail: 
The Basics
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Chapter 2: The “How To...” Chapter
The information in this chapter is designed to help you get the most from 
the StuffIt Deluxe package by providing “How To...” topics that cover 
every day compression tasks. It assumes that you are already comfortable 
with basic archiving tasks such as expanding archives and encoded files 
with StuffIt Expander, and compressing files with DropStuff. If you need 
information about these tasks, see “” on page 4 in Chapter 1 or “” on 
page 6 in Chapter 1 for more information. The topics are organized around 
common questions that we've received over the years about how to use 
some of the more popular features in    StuffIt Deluxe.

• How do I make an archive in the StuffIt Deluxe application?
• How do I browse the contents of an archive?
• How do I extract files from an existing archive?
• How do I add files to an existing archive?
• How do I search for files in an archive?
• How do I segment files into smaller pieces?
• How do I add a comment to an archive?
• How do I add a Return Receipt request to an archive?
• How do I add a password (encrypt) an archive?
• How do I scan for viruses when expanding archives?
• How do I encode files?
• How do I install Palm applications from an archive?
• How do I create archives with error correction?

In addition to creating archives using DropStuff, the Magic Menu, and the 
StuffIt Contextual Menu (as explained in the previous chapter), you can 
also create archives using the StuffIt Deluxe application. When you create 
an archive in the StuffIt Deluxe application, you first create a new empty 
archive, and then add content. To create a new empty archive in the StuffIt 
Deluxe application:

1. Launch StuffIt Deluxe
2. Click the “New” button on the StuffIt Deluxe toolbar
3. In the dialog that appears, choose a name and location for your 

new archive. You can also use the “Archive Type” toggle menu 
to select the format your new archive will use. You can create 
StuffIt (.sit), Zip (.zip), or StuffIt X (.sitx) archives using the 
StuffIt Deluxe application.
Overview

How do I create 
an archive with 
StuffIt Deluxe
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Once you have named and saved your new archive, a new empty archive 
window will appear. You can add content to your new archive by dragging 
and dropping files or folders from the Finder into the new archive.

Often, when you receive an archive, you'll want to take a look at the files it 
contains before you expand them. The StuffIt Deluxe application allows 
you to do just that. When you open an archive with StuffIt Deluxe, rather 
than StuffIt Expander, you will be able to browse through its contents in 
much the same way you browse through the contents of a folder or a hard 
drive. StuffIt Deluxe 7.0 allows you to open the contents of StuffIt archives 
(.sit), StuffIt X archives (.sitx), Zip archives (.zip), and Tape Archives 
(.tar), including those that have been compressed with Bzip2, Gzip, or 
UNIX compression (.tbz2, .tgz, .tar.Z).

When you have StuffIt Deluxe installed on your system, you can open 
StuffIt and Zip archives for browsing by double clicking them.

When you have an archive open in the StuffIt Deluxe application, its 
contents will be organized by folder. When you see a folder in the StuffIt 
Deluxe application, you'll notice that a disclosure triangle is displayed 
beside it. You can see the contents of a folder inside an archive by clicking 
the disclosure triangle. In this respect, the view inside of an archive works 
in much the same way as "List" view in the Mac OS. You can also display 
the contents of a folder in a new window by double clicking it.

When you view the contents of an archive in the StuffIt Deluxe application, 
various information about the files it contains are displayed to you. In 
much the same way as you would find information about a file in the 
Finder using the Mac OS List view, StuffIt Deluxe uses a column based 
view to provide you with information about the files in an archive. The 
StuffIt Deluxe application has columns available for Kind, Label, Date 
Modified, Size, Compressed Size, and percent Saved. You can sort the list 
view that StuffIt Deluxe uses to display the contents of an archive, by 
clicking any of the column headers. To reverse the sort order, click the 
same column heading a second time. You can choose what columns are 
How Do I Browse 
the contents of an 
archive?
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used by StuffIt Deluxe in the Preferences dialog. You can also drag 
columns around to reorder them just as you can in the Finder.

The window used by StuffIt Deluxe to display the contents of an archive 
also displays additional information about the archive and the files it 
contains. In the top right corner of the archive window, StuffIt Deluxe 
calculates the size and compressed size of all the files in the archive, and 
also provides an archive wide "percent saved" number. 

If an archive contains items that have been encrypted with a password, 
those items will be displayed with a key as part of their icon. You will need 
to know the correct password in order to extract these items from an 
archive.

The format of the current archive is displayed in the archive status bar. 
Also in the Status bar are buttons that allow you to easily add edit or 
remove Return Receipt requests and comments.

The easiest way to extract a file from a StuffIt Deluxe archive is simply to 
drag and drop the file you want to extract from the archive window to a 
Finder window. After you've dropped the file to the desired location, a 
progress bar will be displayed while StuffIt extracts the file from the 
archive. You can extract multiple items using drag and drop by making 
multiple selections in the archive window. You can click and drag within 
the archive window to select multiple items that are next to each other in 
the list. To select multiple items that are not next to each other in the list, 
hold down the shift key while you are selecting files. When you have the 
items you want to expand selected, drag and drop them to a Finder window.

You can also extract files from an archive by using the “UnStuff” 
command. You can access the UnStuff command from the StuffIt Deluxe 
Toolbar, from the Archive menu, and from the Context menu what appears 
when you Control (Ctrl) click items in the archive Window. When you 
extract using the UnStuff command, you will be prompted to select a 
location to which files should be expanded.

Note: Files extracted from an archive are copies of the compressed 
file in the archive. The compressed file remains in the archive 
unless you choose to delete it.

If any of the items you are extracting have been encrypted with a password, 
you will be prompted to enter the password before the items can be 
extracted.
How do I Extract 
Files from an 
Archive?
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In addition to extracting files from an archive, you can also choose to 
delete files from the archive. To delete, select the file you want to delete 
and click the “Delete” button on the StuffIt Deluxe Toolbar.
In addition to allowing you to browse and extract files from an open 
archive, the StuffIt Deluxe application also allows you to add files to an 
open archive. This feature is especially useful when you want to maintain 
an archive with the latest versions of all your important documents.

The easiest way to add files to an archive open in StuffIt Deluxe is to drag 
and drop them from a Finder window to the archive window. You can add 
multiple items at once by making a multiple selection in the Finder and 
dragging the files into the archive window. When you drop the files into the 
archive, you will see a progress bar while the items are being compressed.

You can also add files to an archive using the "Stuff" command. The Stuff 
command can be accessed from the StuffIt Deluxe Toolbar, from the 
Archive menu, and from the context menu that appears when you Control 
(ctrl) click items in the archive window. When you use the Stuff command, 
you will be prompted to select the files to add to the archive in a Standard 
file selection dialog.

If you have indicated that items should be encrypted with a password, you 
will be prompted to enter the password before the items are compressed 
into the archive.

In addition to adding files to a StuffIt archive, you can also rename, copy, 
and move items that are stored in an archive. To rename an item, select a 
file, and then click its name to activate the edit name text field. Click in the 
text field to activate the cursor. To move a file, select the item you want to 
move, and drag and drop it to its new location in the archive. To copy a file 
in an archive, drag and drop while holding down the Option key. Again, 
this works just like copying files in the Finder. 

Note: StuffIt X (.sitx) archives can be created with redundancy. Cre-
ating archives with redundancy means that if they become damaged 
due to transfer error or bad media, StuffIt can rebuild there con-
tents. While you can open, browse, and extract files from a StuffIt X 
archive created with redundancy in the StuffIt Deluxe application, 
you cannot add new files, or other wise manipulate them. 
How do I Add 
Files to an Exist-
ing Archive?
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The StuffIt Deluxe package includes an application called ArchiveSearch 
that allows you to search for files located in archives in the same way that 
you use Sherlock to search for files on your computer. You can launch 
ArchiveSearch by choosing “Find” in the edit menu of the StuffIt Deluxe 
application, or you can double click the ArchiveSearch application icon 
which is located in the StuffIt Deluxe product folder. 

When you launch ArchiveSearch, its default configuration will prompt you 
to enter the name of the file you are looking for. When you enter the name, 
and click Search, ArchiveSearch will look for a file that matches the name 
you provided in StuffIt, StuffIt X, and Zip archives located on all available 
local volumes.

When ArchiveSearch finds a matching item, the results window is 
displayed. The results window displays a list of all matching items, when 
you select a matching item the lower pane of the results window shows you 
where the matching file can be found. 
How Do I Search 
for files in an 
Archive?
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When you Control (ctrl) click on a matching file, ArchiveSearch provides a 
contextual menu that allows you to perform a variety of tasks.

• Close window: Closes the results window.
• Open Item: Extracts the selected item from the archive, and 

opens it. For applications, this will result in the application file 
launching, and for documents, the document will open in its 
parent application (if it is available).

• Reveal Item: Opens the archive that contains the selected item, 
and highlights the file in the StuffIt Deluxe application.

• Expand Item: Expands the selected item from the archive.
• Expand to...: Expands the selected item from the archive. You 

will be prompted to select a location to which the file should be 
expanded.

• Expand to Desktop: Expands the selected item from the 
archive to the desktop folder.

• Expand to Document folder: Expands the selected item from 
the archive to the documents folder.

• Copy Item Name: Copies the name of the selected item to the 
clipboard.

If the matching item is encrypted with a password, you will have to enter 
the password before you can open or expand it.

ArchiveSearch also provides many advanced search options that allow you 
to refine the search. Click the "More Options" button to reveal the 
additional options. Specify the advanced options in the ArchiveSearch 
dialog in exactly the same way as you would for Sherlock searches on your 
computer. 

StuffIt Deluxe allows you to create segmented archives. This feature is 
useful if you need to split a large file into smaller pieces. Using the 
Segment feature of StuffIt Deluxe you can take a large movie or sound file, 
for example a 2Gb file, and split it up into smaller pieces so that you can 
create a backup on CD-ROM. Segmenting is also useful if your E-mail 
service limits the size of attachments you can send via E-mail. If your 
E-mail service limits you to 1mb attachments, and you need to send a file 
that compresses to 2mb, you can use the segment feature to split the file in 
two, and attach it to two different E-mail messages.

The easiest way to segment a file is with DropSegment. You can find the 
DropSegment application in the StuffIt Drag and Drop folder in the StuffIt 
Deluxe product folder. To specify the size of the segments that 
DropSegment will create, you must first open the Preferences dialog. To do 
How Do I        
Segment a File 
into smaller 
pieces?
Chapter 2: The “How To...” Chapter - 16



StuffIt Deluxe 8.0 Users Guide
this choose Preferences from the “Edit” menu (Mac OS Classic) or the 
DropSegment menu (Mac OSX). 

The Segment Size toggle menu includes many default options that 
correspond to the size of popular types of backup media, such as CD 
ROMS. You can also select a custom segment size by choosing “Other...”. 
Click the “OK” button to confirm your selection. Drag and Drop the file 
you want to segment on top of the DropSegment icon, or into the 
DropSegment application window. 

The segments that are created will be named .sit.1, .sit.2, etc. To expand 
these segments, simply drag and drop them on top of StuffIt Expander. 
StuffIt Segments are cross platform compatible, and they can be opened on 
a Windows computer using StuffIt Standard Edition or StuffIt Deluxe. You 
can also rejoin StuffIt segments on Linux and Solaris, using the version of 
StuffIt available on those platforms.

Note: DropSegment does not compress your files before it breaks 
them into pieces. Before you segment your file, we recommend first 
compressing it into a StuffIt X (.sitx) archive. You may find that you 
can compress your file to the desired size without having to segment 
it.

You can also create segments using Magic Menu and the StuffIt Content 
menu. To create a segment using the StuffIt contextual menu, Control (ctrl) 
click the file you want to segment, and choose Segment from the Stuffit 
menu. To segment using the Magic Menu, select the file you want to use, 
and choose “Segment” from the Magic Menu. To select the segment sizes 
choose Preferences from the StuffIt menu, or Magic Menu, and when the 
Menu Preferences dialog is displayed, click the Segment icon from the 
Preferences toolbar.

Using the StuffIt Deluxe application, it is possible to add comments to 
StuffIt, StuffIt X and Zip archives. Comments can be used for any number 
of purposes, including providing information about the files the archive 
contains, and instructions for their use. You can also use comments to 
provide contact information so that the recipient can contact you if they 
have questions.
 
To add a comment to your archive, you must first open the archive in the 
StuffIt Deluxe application. When the archive is open, at the bottom left of 
the archive window there are two pop-up buttons. One is used to add 
Return Receipt requests, the other is used to add comments. Click the 
comment button and choose "Edit". In the dialog that appears, type in your 
How Do I Add a 
Comment to an 
Archive?
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comments. Click the "OK" button to add the comment to your archive. You 
can also use the "Edit" dialog to change existing comments.

StuffIt Deluxe supports a special feature where-by anybody opening an 
archive you create will be prompted to send you an email to confirm that 
they were able to successfully extract the contents. To enable this feature 
(which is off by default) you need to add a Return Receipt request. Return 
Receipts can be added either via the Magic Menu, the StuffIt contextual 
menu or the StuffIt Deluxe application. To configure a Return Receipt, you 
need to provide your name, your email address, and a comment that the 
user will see when prompted to respond. 

To add a return receipt request using StuffIt Deluxe: 
 

1. First create the archive to which the return receipt will be 
added, and then open that archive in the StuffIt Deluxe applica-
tion.

2. From the Archive menu choose "Return Receipt->Add".
3. In the fields provided, enter your name, the email address to 

which the Return Receipt should be sent, and a comment.
4. Click OK to add the return receipt to your archive.
 

Once a Return Receipt has been added to an archive you can also modify 
and remove it from within the StuffIt Deluxe application.
 
To Modify a Return Receipt in an existing StuffIt archive:

1. Open the archive in the StuffIt Deluxe application.
2. From the Archive menu choose "Return Receipt->Modify
3. Make your changes, and click OK to save them.

To remove a Return Receipt in an existing StuffIt archive:
 

1. Open the archive in the StuffIt Deluxe application.
2. From the Archive menu choose "Return Receipt->Remove".

StuffIt Deluxe allows you to protect your files by encrypting them with a 
password as they are added to an archive. StuffIt Deluxe allows you to 
create encrypted StuffIt, StuffIt X, and Zip archives using several different 
methods. 

Note: When you create archives with encrypting using StuffIt 
Deluxe it is very important that you keep your password in a safe 
place. If you loose your password you will not be able to expand the 
How Do I Add a 
Return Receipt 
request to an 
Archive?

How Do I Create 
an Encrypted 
Archive?
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items in your archive. Aladdin is not able to recover the contents of 
an encrypted archive if you have lost your password.

StuffIt Deluxe supports strong encryption. When you use either DropStuff, 
StuffIt Deluxe, Magic Menu, or the StuffIt contextual menu to create an 
encrypted StuffIt X archive, strong 512bit encryption will automatically be 
used.

Use the following steps to create an encrypted archive with DropStuff:
 

1. Launch DropStuff
2. Choose Preferences from the DropStuff menu (Mac OS X) or 

from the Edit menu (Mac OS Classic).
3. Click the "Stuffing" icon.
4. Check the "Encrypt archives with password" box.
5. Click OK.

 
When you create archives with DropStuff when encryption is turned on, 
you will be prompted to enter and confirm a password before you files are 
compressed.

Use the following steps to create an encrypted archive with DropZip:
 

1. Launch DropZip
2. Choose Preferences from the DropZip menu (Mac OS X) or 

from the Edit menu (Mac OS Classic).
3. Click the "Zipping" icon.
4. Check the "Encrypt archives with password" box.
5. Click OK.

 
When you create archives with DropZip when encryption is turned on, you 
will be prompted to enter and confirm a password before you files are 
compressed.

Use the following Steps to create an encrypted archive with Magic menu 
and StuffIt contextual menu:
 

1. Choose Preferences from the Magic Menu (click the desktop if 
the Magic Menu is not currently available)

2. Click the "Compression" icon.
3. Check the "Encrypt archives with password" box.
4. Click OK.

 

How Do I 
Encrypt using 
DropStuff?

How Do I 
Encrypt Using 
DropZip?

How Do I 
Encrypt Using 
the Magic Menu? 
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When you use the Magic Menu or the StuffIt contextual menu to create 
Zip, StuffIt, or StuffIt X archives, you will be prompted to enter and 
confirm a password. 

Use the following steps to create an encrypted archive with the StuffIt 
Deluxe application:
 

1. Launch the StuffIt Deluxe application.
2. Choose Preferences from the StuffIt Deluxe menu (Mac OS X) 

or from the Edit menu (Mac OS Classic).
3. Click the "Compression" icon.
4. Check the "Encrypt archives with a password" button.

 
When you add items to an archive using either drag and drop or the Stuff 
command, you will be prompted to enter and confirm a password. 

StuffIt Deluxe allows you to create encoded files, in addition to creating 
archives. Encoding typically means that a file is translated from a binary 
(such as an application) into a text file. Encoding is typically used when 
you are posting files to a News Group, FTP server, or sending files via E-
mail. For most file transfers it is not necessary to encode the files yourself, 
for example when you send files via E-mail your E-mail client will perform 
any necessary encoding for you. Sometimes, however, you will run in to 
situations where you need to encode the file yourself before uploading it.
 
Note: It is not necessary to encode a StuffIt or StuffIt X archive that will be 
made available via either a web site or an FTP server. These archive types 
include only a single data fork and will not be damaged if they are stored 
on a Windows or Unix file system.
 
StuffIt allows you to encode in the following formats: BinHex (.hqx), 
MacBinary (.bin), UUEncode (.uu), and Mime/Base 64 (.mm). You can 
only encode a single file at a time. If you need to encode multiple items and 
need them to be contained in a single file, you should first compress your 
files into a StuffIt archive, and then apply the encoding.
 
To encode using one of the above formats:
 

1. Select the file you want to encode.
2. From the Magic Menu choose the Encode menu.
3. Select the encoding method you want to use.

 

How Do I 
Encrypt Using 
StuffIt Deluxe?

How Do I Encode 
Files?
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You can also create encoded files from the StuffIt contextual menu. Control 
(ctrl) click the file you want to encode, and choose the format you wish to 
use from the StuffIt->Encoding menu.

StuffIt Expander includes a feature that allows you to automatically scan 
files expanded from an archive with your Virus checking software. 
Currently, StuffIt Expander supports scanning for viruses using Norton 
AntiVirus, Virex, and Virus Barrier. You can choose another anti-virus 
program by choosing “Other...” from the pop-up menu.
 
To scan files for viruses as they are expanded from an archive:
 

1. Launch StuffIt Expander.
2. Choose "Preferences" from the StuffIt Expander menu (Mac 

OS X) or the Edit menu (Mac OS Classic).
3. Click the "Expanding" icon.
4. Check the "Scan for Viruses using..." check box.
5. Use the toggle menu to select the virus program that you have 

installed.
6. Click OK.

 
The next time you expand an archive using StuffIt Expander, your Virus 
utility will automatically be launched and your files will be scanned as they 
are expanded.

StuffIt Expander can automatically detect Palm applications located in 
StuffIt archives, and launch them in the Palm Desktop Conduit so that they 
will be installed the next time you sync your palm. To turn on this feature:
 
Launch StuffIt Expander.
"Choose Preferences" from the StuffIt Expander menu (Mac OS X) or the 
Edit menu (Mac OS Classic)
Click OK.
 
The next time you expand an archive that contains a Palm application, that 
application will be automatically set up so that it is installed next time you 
sync your Palm.

When you are creating archives in StuffIt X (.sitx) format, StuffIt Deluxe 
allows you to create them with error correction. Archives created with error 
correction are larger than those created without, but if they become 
corrupted you are typically able to recover the contents. Error correction is 
useful if you are sending particularly valuable files across the Internet, and 
How Do I Scan 
for Viruses when 
Expanding an 
Archive?

How Do I Install 
Palm 
Applications from 
Archives?

How Do I Create 
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Redundancy 
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want to ensure that they will arrive intact. Using error correction can also 
be useful if you are creating a backup of your files to removable media. If 
that media becomes corrupted, you stand a better chance of recovering 
your data if the archives are created with error correction.

Use the following method to create archives with error correction using 
DropStuff
 

1. Launch the DropStuff application.
2. Choose Preferences from the DropStuff menu (in Mac OS X) or 

the Edit menu (Mac OS Classic)
3. Click the Stuffing icon.
4. Choose “StuffIt X” as the archive type.
5. Check the “Add Error Correction” check box.
6. Click the OK button.

 
Archives that you create with DropStuff will now include error correction.

Use the following method to create archives with error correction using 
Magic Menu or the StuffIt Context menu

1. Choose Preferences from the Magic Menu to open the Menu 
Preferences dialog (click the desktop if Magic Menu is not cur-
rently available.

2. Click the StuffIt icon in the Preferences Toolbar.
3. Make sure the StuffIt Archive Toggle menu is set to "StuffIt X"
4. Check the "Add Error Correction" check box.
5. Click OK.

Archives created with either Magic Menu or StuffIt contextual menu will 
now include error correction.
 
Creating Error Correction archives with the StuffIt Deluxe application
 
You can add Error Correction to an archive that is currently open in the 
StuffIt Deluxe application using the "Save a Copy as..." command in the 
File Menu.
 

1. From the File menu choose "Save a Copy As..."
2. Make sure that the Format toggle menu is set to StuffIt X.
3. Click the Options button.
4. In the Options dialog, Make sure the Error Correction toggle 

menu is set to On.
5. Click OK.
6. Choose a name and location for the new copy.
7. Click the Save button.
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StuffIt Deluxe will now create a copy of the currently open archive with 
Error Correction.

Note: Once redundancy has been added to a StuffIt X archive, it 
effectively becomes “locked”; the addition of error correction 
information to the archives means that no new files can be added, 
and the existing files cannot be changed. If you need to edit the con-
tents of a StuffIt X archive created with redundancy, use the “Save a 
Copy As...” feature in StuffIt Deluxe to save a new copy of the 
archive that does not include the error correction information.
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Chapter 3: StuffIt Expander™
StuffIt Expander is used to expand archives, encoded files, 
and other compressed and encoded documents. For a full 
list of the file types supported by StuffIt Expander, check 
out the StuffIt Reference chapter. 

StuffIt Expander is easy to use! To expand a file with StuffIt Expander, 
simply drag and drop the file you want to expand onto the StuffIt Expander 
icon. You can also expand files with StuffIt Expander by dragging files 
onto the StuffIt Expander application window. You can expand more than 
one file by dragging multiple items onto StuffIt Expander, and you can also 
expand larger groups of files by placing them in a folder and dragging the 
whole folder onto StuffIt Expander.

Note: Even if the Mac OS does not recognize that a file can be 
expanded by StuffIt Expander, you may still be able to expand it. 
Even if the file you want to expand doesn’t have a StuffIt icon, drag 
and drop it onto StuffIt Expander to see if it can be expanded.

While all of the functionality of StuffIt Expander can be accessed using 
Drag and Drop, you can also expand files using commands accessed from 
Expander’s menus.

To Expand using menu commands, choose “Expand” from the File menu 
and select the archive or encoded file you want StuffIt Expander to open.

You can change the behavior of StuffIt Expander using the StuffIt 
Expander preferences dialog. To open StuffIt Expander preferences, 
Overview

Using StuffIt 
Expander

StuffIt Expander 
Menus

StuffIt Expander 
Preferences
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choose Preferences from the “StuffIt Expander” menu in Mac OS X, or 
Preferences from the “Edit” menu in Mac OS 8.6-9.x. 

The Expanding Preferences are used to determine how StuffIt Expander 
goes about the task of expanding an archive or encoded file.

• Expand Archives and Compressed Files: When this prefer-
ence is enabled, StuffIt Expander will expand archives and 
compressed files.

• Delete [archives and encoded files] after expanding: This 
preference is active only when Expand archives and com-
pressed files is enabled. When it is enabled, the archives and 
compressed files you expand will be deleted once the files they 
contain are successfully extracted. Use this preference with cau-
tion!

• Expand Encoded Files: Use this preference to determine 
whether or not StuffIt Expander should attempt to expand 
encoded files.

• Delete [encoded file] after expanding: This preference deter-
mines whether or not encoded files should be deleted after they 
have been expanded. Use this preferences with caution!

• Continue to expand (if possible): This preference, when 
enabled, causes StuffIt Expander to scan the file that results 
from expanding an archive, compressed, or encoded file to see 
if it can be further expanded. For example, when this preference 
is enabled, and StuffIt Expander encounters a BinHex encoded 
StuffIt archive, it will start to expand the archive as soon as it 
has decoded the BinHex layer.

Note: Archives, compressed, and encoded files contained within 
folders in the archive must be separately expanded.

• Ignore Return Receipt messages: Causes StuffIt Expander to 
ignore Return Receipt messages in StuffIt archives. See “How 
Do I Add a Return Receipt request to an Archive?” on page 18 
for more information on how to add a Return Receipt message 
to an archive.

• Scan for Viruses: StuffIt Expander allows you to automatically 
scan files that are extracted from archives and encoded files for 
viruses with your virus protection software. StuffIt Expander 
supports Virex, Norton Anti-Virus, and Virus Barrier. If you 
would like to try using a different Virus program, choose 
“Other...” from the pop-up menu.

• Open Palm .prc and .pdb files: StuffIt Expander can automat-
ically open Palm application programs in the Palm installation 
Expanding Prefs
Chapter 3: StuffIt Expander - 25



StuffIt Deluxe 8.0 Users Guide
program. When this preference is enabled, any Palm application 
expanded from an archive will be set up for installation in the 
Palm installation program.

• Show Drag window: This preference determines whether or 
not StuffIt Expander’s drag and drop window is displayed.

The joining preferences determine how StuffIt Expander will handle files 
that have been segmented.

• Join Segmented Files: When this preference is enabled, StuffIt 
Expander will attempt to join files that have been segmented 
with StuffIt.

• Delete Segments after joining: When this preference is 
enabled, StuffIt Expander will delete the segments once the 
rejoined file has been saved. Use this preferences with caution.

• Expand joined files (if possible): When this preference is 
enabled, StuffIt Expander will attempt to expand the rejoined 
file if it is a archive, compressed, or encoded file.

Disk Image preferences determines how StuffIt Expander will handle disk 
image files.

• Mount Disk Images: When this preference is enabled, StuffIt 
Expander will attempt to mount disk image files. 

Note: StuffIt Expander is not able to mount .dmg disk image files 
created by Disk Copy under OS X. These disk images must be 
mounted with the Disk Copy application.

• Keep Mounted Images in RAM: When this preference is 
enabled, StuffIt Expander will keep the mounted disk image in 
RAM if there is enough free memory available. A disk image 
mounted in RAM has the same properties as a RAM Disk cre-
ated under classic versions of the Mac OS.

• Mount images unlocked by default: When this preference is 
enabled, StuffIt Expander will attempt to mount disk images as 
unlocked (read/right) volumes.

Note: Images that include compression can only be mounted as 
locked volumes.

The Destination preferences determine where StuffIt Expander will save 
files that have been extracted from archive, compressed, or encoded files.
Joining Prefs

Disk Images 
Prefs

Destination Prefs
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You can choose the location where files are extracted. The following 
options are available:

• Same as Original: When this option is selected, files will be 
saved to the same location as the archive, compressed, or 
encoded file from which they were expanded.

• Ask: When this option is selected, StuffIt Expander will prompt 
you to specify a location to which files should be expanded.

• Use...: Use this option to specify a location to be used every 
time StuffIt Expander saves a file.

You can also specify whether or not StuffIt Expander should place 
expanded files into a new folder.

• When the archive contains multiple items: When this option 
is selected, StuffIt Expander will create a surrounding folder 
whenever the archive contains multiple items at the root level. 
The name of the archive will be used for the newly created 
folder.

• Never: StuffIt Expander will never create a surrounding folder.
• Always: StuffIt Expander will always create a surrounding 

folder.

You can tell StuffIt Expander to monitor and expand files in a particular 
folder, called the “Watch” folder. You can use the Watch Folder feature to 
scan your Internet download folder so that files you download from the 
Internet, regardless of the web browser or utility used, are always 
expanded.

• Check for Files to Expand in: This setting allows you to select 
a target folder for StuffIt Expander to Watch. 

Once StuffIt Expander has scanned the target folder, you can specify what 
happens next:

• Wait...: You can tell StuffIt Expander to stay running and watch 
for new files to expand in a specified number of minutes.

Note: To Stop StuffIt Expander from expanding the same file over 
and over again, you can configure the application to automatically 
delete archives after they have been expanded. Be aware, however, 
that if the archive is damaged and is not expanded, it will have to be 
replaced before you can try expanding it again. 
Watch Folder 
Prefs
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• Quit: You can tell StuffIt Expander to Quit after files have been 
expanded. 

Note: You will see a “Quit Pending” dialog displayed when StuffIt 
Expander is about to quit. You can use this time to open the prefer-
ences dialog and change the setting so that StuffIt Expander does 
not quit after expanding files.

This preference determines how StuffIt Expander will handle errors that 
occur while files are being expanded.

• Report Errors using alert window: Errors will be displayed in 
an alert window created by the application. Each error must be 
dismissed before the application can continue.

• Ignore errors: Errors will not be reported at all. Expansion will 
continue where possible.

• Log errors to: Errors be logged to a text file.

This preferences determines whether or not StuffIt Expander should check 
for updates and upgrades over the Internet when it is launched.

The Internet Preferences page is used to determine which file types are 
automatically associated with StuffIt Expander by Internet applications 
such as web browsers.

If you are exchanging files with a Windows user, StuffIt Expander can help 
to make the files you receive ready for use on your Macintosh. In addition 
to expanding the contents of a zip archive from a PC computer, StuffIt 
Expander will also automatically translate the file extension of a Windows 
file into a Macintosh type and creator code. This means that when you 
double click the file it will open in the correct application (assuming, of 
course, that you have an application able to open the kinds of files you 
expanded.) 

Please!: If you don’t have an application able to open a file you’ve 
expanded with StuffIt Expander, call the person who sent you the 
file not us. Thanks!
Error Reporting 
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Chapter 4: DropStuff™
This chapter is designed to provide detailed information 
about the StuffIt Drag and Drop applications that are 
included in the StuffIt Deluxe package. These applications 
allow you to perform simple compression tasks by dragging 
and dropping files onto either the application window, or 
the desktop icon. If you are looking for basic information 

about how to create archives, and expand archives and encoded files, we 
recommend that you first read the Getting Started chapter before you read 
this chapter.

DropStuff is used when ever you want to compress files and folders into a 
StuffIt archive. DropStuff can create both StuffIt (.sit) and StuffIt X (.sitx) 
archives, and can create both self-extracting archives, and archives with 
encryption.

To use DropStuff, drag and drop files and/or folders on to either the 
DropStuff icon, or into the new DropStuff application Window. When you 
drag and drop multiple items, those items are combined into a single 
archive file. 

DropStuff 8.0 includes a number of changes that are designed to make the 
application even easier to use! When you launch the DropStuff application, 
the drag and drop window now features a pop-up menu that allows you to 
easily switch between creating StuffIt and StuffIt X archives, and you can 
also turn on DropStuff's powerful strong encryption feature by checking 
the box that is provided. 
Overview
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DropStuff now includes a powerful new feature that allows you to control 
exactly which files contained in a folder will get added to the archive when 
you drag and drop that folder onto DropStuff. Using a “Find…” like 
interface, DropStuff's filters will allow you to specify search parameters, 
and these parameters are then used as a filter when the folder is being 
compressed. Files that match the parameters specified pass the filter, files 
that do not match the parameters are blocked by the filter. 

You can use this feature, for example, to archive your Documents folder so 
that only files that have been changed (modified) in the last week will be 
added.

1.Launch the Drop Stuff application.
2.Hold down the Option and Control keys and drag and drop your Doc-
uments folder into the DropStuff window.
3.Before the files are compressed, the DropStuff filter window will 
open allowing you to specify exactly which files will pass through the 
filter.
4.From the “Add Criteria…” pop-up menu, choose “Date Modified”.
5.From the “Date Modified” pop-up menu choose, “Is With-in”, and 
then choose “1 week” from the pop-up menu that appears next.
6.Click the OK button to continue with the compression of the folder.

You can also access the “Stuff with Filter” function from the DropStuff File 
menu, or by dragging and dropping on the DropStuff icon using the Option 
and Control modifier keys.

While DropStuff is designed to be used as a drag and drop application, you 
can compress files using the “Stuff” command in the DropStuff File menu. 
When you choose “Stuff” from the File menu, a file selection dialog will be 
used to allow you to select files to compress. Again, if you select multiple 
files in the selection dialog, they will be combined into a single archive 
file.

DropStuff Preferences can be used to change the compression format used 
by DropStuff when it creates archives, to set the level of compression used, 
and to set advanced options such as making self-expanding and encrypted 
archives.

The “Stuffing” page contains settings that relate to how the application 
creates StuffIt archives.
New ! DropStuff 
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• Archive Type: DropStuff is able to create StuffIt (.sit) 
archives, or StuffIt X (.sitx) archives. The default archive type 
is .sit.

• Compression Level: As well as changing the format in which 
the archive will be created, you can also change the 
compression level that will be used when items are added to the 
archive. The choices are “Faster” and “Better”; as the names 
suggest the “Faster” compression method makes archives more 
quickly, and the “Better” compression method creates smaller 
archives. An additional choice, “Custom” is also available. 
When “Custom” is selected you can use the Advanced 
Compression Preferences dialog to determine how DropStuff 
will compress your files. See “Chapter 15: Expert Compression 
Settings” on page 88 for details.

• Encrypt Archives with a Password: When this option is 
checked, the archives you create will be encrypted with a pass-
word. You will be prompted to provide a password before the 
compression begins.

Note: When you create an archive with encryption, be sure to make 
a careful note of your password. Aladdin cannot recover files from 
encypted archives if you have lost your password. Also note that 
passwords are case sensitive.

• Make Self-Extracting for...: When checked, this preference 
will cause DropStuff to create self-extracting archives. Self-
Extracting archives open automatically without any special 
expansion software. You can choose to create self-extracting 
archives for Mac and Windows.

• Add Error Correction: When this option is selected, the Stuf-
fIt X archive you create will contain error correction code to 
protect them from corruption caused by bad media, or transfer 
errors.

The following options effect how DropStuff goes about the job of adding 
files to an archive.

• Delete Originals After Stuffing: The original files that were 
compressed into the archive will be deleted from your hard 
drive when the archive is created.

• Stuff each Item as an individual archive: When this option is 
set, when you drag multiple items onto DropStuff, each item 
will be compressed as an archive. The items will not be com-
bined into a single archive file as they are compressed.
Options Prefs
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• Don’t Stuff files that are already compressed: File types that 
are known to already include compression (such as Gif images, 
or QuickTime movies) will not be compressed when they are 
added to an archive.

• Ignore Finder Desktop Files: When this option is set, Drop-
Stuff will not add Finder files (such as Desktop Database files 
or .DStore) to an archive.

• Show Drag Window: When this option is set, DropStuff will 
display a drag and drop window when the application runs. You 
can compress files and folders by dragging them onto this win-
dow.

The options in the BinHexing page allow you to instruct DropStuff to 
BinHex encode a StuffIt or StuffIt X archive after it has been created. You 
can configure this behavior so that the archive is deleted after it has been 
encoded, and you can also choose to remove the .sit or .sitx from the file 
name; the archive will be named file.hqx, rather than file.sitx.hqx.

The settings in the Destination page where on your hard drive the new 
archive file will be created.

• Same As Original: By default, the archive is created in the 
same location as the original files that were compressed. 

• Ask: This option causes DropStuff to prompt you to specify a 
location to which the archive will be saved.

• Use: This option allows you to specify a location on your hard 
drive to which all archives created with DropStuff will be 
saved.

This option allows you to specify whether or not DropStuff should check 
online for updates or newer versions. This preferences is on by default.
BinHexing Prefs

Destination Prefs
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Chapter 5: DropZip™
DropZip is used when ever you want to compress files and 
folders into a Zip archive. DropZip can also be used to cre-
ate Zip files that are encrypted with a password. DropZip 
functions in an almost identical manner to DropStuff, 
except that zip archives are created instead of StuffIt 
Archives. Typically you’ll want to create zip archives when 

you send files to people using PC based computers. 

Tip: Zip archives will typically be a little larger that StuffIt or StuffIt 
X archives made from the same data. Before you send zip archives 
to a Windows user, you should first consider sending them StuffIt 
Expander for Windows so that they can open the StuffIt and StuffIt 
X archives you send them. StuffIt Expander can be downloaded for 
free at http://www.stuffit.com

To use DropZip, drag and drop files and/or folders on to either the DropZip 
icon, or into the new DropZip application Window. When you drag and 
drop multiple items, those items are combined into a single archive file. 

While DropZip is designed to be used as a drag and drop application, you 
can compress files using the “Zip” command in the DropZip File menu. 
When you choose “Zip” from the File menu, a file selection dialog will be 
used to allow you to select files to compress. Again, if you select multiple 
files in the selection dialog, they will be combined into a single archive 
file.

DropZip Preferences can be used to change the compression level used 
when creating a zip archive, and can also be used to encrypt zip files with a 
password.

• Compression Level: Compression Level allows you to change 
the compression level that will be used when items are added to 
an archive. The choices are “Faster” and “Better”; as the names 
suggest the “Faster” compression method makes archives more 
quickly, and the “Better” compression method creates smaller 
files. An additional choice, “Custom” is also available. When 
“Custom” is selected you can use the Advanced Compression 
Overview

Using DropZip

DropZip Menus

DropZip Prefer-
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Preferences dialog to configure how DropZip will compress 
your files. See “Chapter 15: Expert Compression Settings” on 
page 88 for details.

• Delete Originals after Zipping: When this option is set, 
DropZip will delete the original files that were added to an 
archive after the archive has been created. 

Warning: Use this option with caution!

• Zip each item as an individual archive: When this option is 
set, multiple items dragged onto the DropZip icon or 
application window will be compressed as individual archives, 
rather than combined into a single large archive file.

• Don’t Zip files that are already compressed: When this 
option is set, DropZip will not attempt to compress already 
compressed files (such as .mp3 audio files or .Gif images) 
before it adds them to an archive.

• Encrypt archives with a password: When this option is set, 
DropZip will encrypt the archives it creates with a password. 
You will be prompted to enter the password before items are 
compressed.

Note: When you create an archive with encryption, be sure to make 
a careful note of your password. Aladdin cannot recover files from 
encrypted archives if you have lost your password. Also note that 
passwords are case sensitive.

• Ignore Finder Desktop Files: When this option is set, DropZip 
will not add Finder files (such as Desktop Database files or 
.DStore) to an archive.

• Show Drag Window: When this option is set, DropZip will 
display a drag and drop window when the application runs. You 
can compress files and folders by dragging them onto this win-
dow.

The options in the UUEncoding page allow you to instruct DropZip to 
UUEncode a Zip archive after it has been created. You can configure this 
behavior so that the archive is deleted after it has been encoded, and you 
can also choose to remove the .zip from the file name; the archive will be 
named file.uu, rather than file.tar.uu.

Macintosh Resource forks are not supported by Zip, Tar, and Lha archives. 
In order to preserve Macintosh Resource fork information it is necessary to 
MacBinary encode these files before they are added to an archive. 
UUEncoding 
Prefs

MacBinary
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Tip: Just StuffIt! (Use StuffIt X archives, that is)

The MacBinary Preferences determines how this MacBinary Encoding is 
preformed.

• Never: Files will never be MacBinary encoded before they are 
added to a zip archive. Macintosh file information will be lost.

• Smart: This means that files that contain extended information 
(such as resource forks) will be encoded before they are zipped, 
files that do not contain extended information will not be 
MacBinary Encoded before they are added.

• Always: This option will cause all files added to a zip archive 
to first be MacBinary encoded, regardless of whether they con-
tain extended file information.

Note: When you pick a MacBinary option, be aware of who will end 
up using your files. If you use MacBinary encoding and send the 
resulting Zip archive to a Windows user, they will most likely 
encounter problems when trying to unzip the contents. By default, 
we assume that you are zipping file because you want to send them 
to Windows users, and therefore the MacBinary preference is set to 
Never by default. The vast majority of Macintosh files are usable 
without there resource forks, so even if Mac users open zip archives 
created without MacBinary encoding, they should not encounter a 
problem using the files contained.

The settings in the Destination page where on your hard drive the new 
archive file will be created.

• Same As Original: By default, DropZip will create archives in 
the same location as the original files that were compressed. 

• Ask: This option causes DropZip to prompt you to specify a 
location to which the archive will be saved.

• Use: This option allows you to specify a location on your hard 
drive to which all archives created with DropZip will be saved.

This option allows you to specify whether or not DropZip should check 
online for updates or newer versions. This preferences is on by default.

When you compress files in zip format using DropZip, you’ll notice that 
they are typically smaller than the zip archives created by any other 
application, including PC applications like WinZip. The zip compression 
Destination Prefs

Version Check-
ing Prefs

Cool DropZip 
Tips and Tricks!
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used by DropZip, and all the other applications in the StuffIt Deluxe 
application, is about 5% more efficient than the zip compression used by 
other applications. Better still, even though DropZip uses an improved 
form of zip compression, the archives you create will still be 100% 
compatible with all the other zip utilities available on the Mac and PC.
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Chapter 6: DropTar™
DropTar is a drag and drop application that function in 
much the same way as DropZip and DropStuff, except that 
it creates archives in Tape Archive (.tar) format. Drag and 
Drop files and/or folders onto the DropTar icon, or the 
DropTar application window, to add them to a new tar 
archive. By default, a tape archive does not contain any 

compression. You can have DropTar automatically compress the resulting 
archive using either Gzip, Bzip, Compress, or StuffIt compression.

Note: Tar archives do not contain any form of compression, so 
you’ll find that the Tar archives you create are the same size as the 
original files and folders that were added. DropTar allows you to 
compress a Tar archive after it has been created using either Gzip, 
Bzip, Compress, or StuffIt compression.

Use DropTar in exactly the same way as you would use DropStuff and 
DropZip. Drag and Drop files and/or folders onto the DropTar icon, or the 
DropTar drag and drop window. When you drag and drop multiple items 
onto DropTar they will be combined into a single tape archive.

DropTar Preferences can be used to change the way in which tar archives 
are created, and whether or not they are created with compression.

• Compression Method: Specifies the compression format that 
will be used to compress the newly created .tar archive. Gzip, 
Bzip, Compress, and StuffIt compression is available.

• Compression Level: As well as changing the compression 
format to be used, you can also change the compression level 
that will be used when items are added to the archive. The 
choices are “Faster” and “Better”; as the names suggest the 
“Faster” compression method makes archives more quickly, 
and the “Better” compression method creates smaller archives. 
An additional choice, “Custom” is also available. When 
“Custom” is selected you can use the Advanced Compression 
Preferences dialog to determine how DropStuff will compress 
your files. See “Chapter 15: Expert Compression Settings” on 
page 88 for details.

•

Overview

Using DropTar

DropTar Prefer-
ences

Archiving Prefs
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• Delete Originals after Archiving: When this option is set, 
DropTar will delete the original files that were added to an 
archive after the archive has been created.

Warning: Use this option with caution!

• Archive each item as an individual archive: When this option 
is set, multiple items dragged onto the DropTar icon, or onto the 
DropTar application window, will each be added to their own 
individual Tar archive.

• Ignore Finder Desktop Files: When this option is set, DropTar 
will not add Finder files (such as Desktop Database files or 
.DStore) to an archive.

• Show Drag Window: When this option is set, DropTar will 
display a drag and drop window when the application runs. You 
can compress files and folders by dragging them onto this win-
dow.

The options in the BinHexing page allow you to instruct DropTar to 
UUEncode a Tar archive, or a compressed tar archive, after it has been 
created. You can configure this behavior so that the archive is deleted after 
it has been encoded, and you can also choose to remove the .tar from the 
file name; the archive will be named file.uu, rather than file.tar.uu.

Macintosh Resource forks are not supported by Zip, Tar, and Lha archives. 
In order to preserve Macintosh Resource fork information it is necessary to 
MacBinary encode these files before they are added to an archive. 

Tip: Just StuffIt! (Use StuffIt X Archives, that is.)

The MacBinary Preferences determines how this MacBinary Encoding is 
preformed.

• Never: Files will never be MacBinary encoded before they are 
added to a tar archive. Macintosh file information will be lost.

• Smart: This means that files that contain extended information 
(such as resource forks) will be encoded before they are 
archived, files that do not contain extended information will not 
be MacBinary encoded before they are added to an archive.

• Always: This option will cause all files added to a tar archive to 
first be MacBinary encoded, regardless of whether they contain 
extended file information.
UUEncoding 
Prefs

MacBinary Prefs
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Note: When you pick a MacBinary option, be aware of who will end 
up using your files. If you use MacBinary encoding and send the 
resulting Tar archive to a UNIX user, they will most likely encounter 
problems when trying to unzip the contents. By default, we assume 
that you are using Tar file because you want to send them to UNIX 
users, and therefore the MacBinary preference is set to Never by 
default. The vast majority of Macintosh files are usable without 
there resource forks, so even if Mac users open Tar archives created 
without MacBinary encoding, they should not encounter a problem 
using the files contained.

The settings in the Destination page where on your hard drive the new 
archive file will be created.

• Same As Original: By default, DropTar will create archives in 
the same location as the original files that were compressed. 

• Ask: This option causes DropTar to prompt you to specify a 
location to which the archive will be saved.

• Use: This option allows you to specify a location on your hard 
drive to which all archives created with DropTar will be saved.

This option allows you to specify whether or not DropTar should check 
online for updates or newer versions. This preferences is on by default.
Destination Prefs

Version Check-
ing Prefs
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Chapter 7: The StuffIt Deluxe Application™
This chapter is designed to provide detailed information about the StuffIt 
Deluxe application. It is the reference you should turn to if you have a 
question about the function of a particular button, menu item, or 
preference. If you are looking for information about how to do a particular 
task, such as adding a file to an archive, please checkout the “How To...” 
guide in chapter 5.

The StuffIt Deluxe application is the tool that allows you to browse and 
manipulate the contents of your archives. The StuffIt Deluxe application is 
able to browse and manipulate the contents of StuffIt (.sit), StuffIt X (.sit), 
and Zip (.zip) archives. When StuffIt Deluxe is installed, you can open 
your archives in the Deluxe application simply by double clicking them. 

The StuffIt Deluxe application also allows you to browse the contents of 
Tape Archives (.tar), including Tape Archives that have been compressed 
using Unix Compress, Bzip, or Gzip compression. While you can browse 
the contents of such files and extract individual items without expanding 
the whole archive, the contents cannot be changed. 

When an archive is open in the Deluxe application, its contents are 
presented to you in much the same way as the Finder presents information 
about the contents of a folder when it is in list view. 

In addition to the standard information you would expect to see about a file 
in a Finder view, such as its name, size, date of modification, and label, 
StuffIt Deluxe also shows you the compressed size of the file and the 
percentage saving gained through compression. You can change the sort 
order of the list by clicking a column heading, clicking the same column 
headings again reverses the sort order. You can choose what column 
heading are displayed by opening the preferences dialog, and clicking the 
Views icon. 
StuffIt Deluxe: 
The Details

Using StuffIt 
Deluxe
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You can add and remove files from an archive using the StuffIt Deluxe 
application in exactly the same way as you would add and remove files 
from a folder in the Finder. Drag files into the window to add them to your 
archive, and drag files from the archive window to the desktop to extract 
them. You can also delete, rename, move, and copy files in an archive 
exactly as you can in the Finder. 
 
StuffIt Deluxe allows you to save a copy of the current archive using the 
"Save a Copy As..." command in the File menu. Clicking the "Options" 
button in the Save As dialog allows you change the compression level, 
encrypt the archive with a password, make the archive self-extracting, and 
add Error Correction (when saving the archive in StuffIt X archive).
 
For a more detailed “How To” that covers browsing the contents of an 
archive, adding files, and removing files, See “Chapter 2: The “How To...” 
Chapter” on page 11.

Most of the features of the StuffIt Deluxe application, such as adding or 
removing files from an archive, can be done by dragging and dropping in 
exactly the same was as you would in the Finder. StuffIt Deluxe, however, 
also provides a toolbar that allows the user to access the various functions 
associated with manipulating the contents of an archive.

The following functions are accessible from the StuffIt Toolbar:
 

• New Archive: The command will cause the StuffIt Deluxe 
application to create a new empty archive. You can have up-to 
nine archives open at the same time in the StuffIt Deluxe appli-
cation.

• Stuff: The Stuff command (also accessible from the Archive 
menu) provides an alternative to drag and drop when it comes 
to adding files to an existing archive. When the Stuff button is 
clicked, a dialog prompts you to select the files that should be 
added to the current archive.

• UnStuff: The UnStuff command provides an alternative to drag 
and drop when it comes to extracting files from a StuffIt 
archive. The UnStuff button becomes active when an archive is 
open and items are selected. When clicked, a dialog prompts the 
StuffIt Deluxe 
Toolbar
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user to select a location to which the selected items should be 
expanded.

• New Folder: The New Folder button allows the user to create a 
New folder in the current archive.

• Delete: The Delete button is active when an archive is open and 
items are selected. The selected items are deleted from the 
archive when the button is clicked. The items are immediately 
deleted, rather than being moved to the Mac OS trash can.

• Get Info: The Get Info button is active when an archive is open 
and items are selected. When used, an Info dialog is opened for 
the selected item. This dialog functions in much the same way 
as the Get Info dialog in the Finder. The dialog displays infor-
mation about the size, and modification date of the file, and also 
allows the user to view and edit its Type and Creator code. 

• Launch: The launch button allows you to UnStuff and launch 
or open a file in a single step. This button is active when an 
archive is open and items are selected. 

 

The StuffIt Deluxe preferences dialog allows you to determine exactly how 
the Toolbar will be displayed on the screen. You can edit the following 
attributes:
 

• Toolbar Orientation: This allows you to specify whether the 
toolbar is aligned vertically or horizontally.

• Toolbar Icon Size: Choose either large or small icons. Large 
icon view is used in the example shown above.

• Anchor Toolbar to top of screen: When checked, the StuffIt 
Deluxe toolbar becomes fixed to the top of the screen.

• Show Names: This setting determines whether or not the name 
of each button will be displayed in addition to the icon.

This topic provides information about the menus available in the StuffIt 
Deluxe application. 

The Following functions are available from the File menu in the StuffIt 
Deluxe application.

• Save a Copy As: StuffIt Deluxe allows you to save a copy of 
the current archive using the “Save a Copy As...” command in 
the File menu. Clicking the “Options” button in the Save As 
dialog allows you change the compression level, encrypt the 
archive with a password, make the archive self-extracting, and 
Setting Toolbar 
Preferences

StuffIt Deluxe 
Menus

The File Menu
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add Error Correction (when saving the archive in StuffIt X 
format).

• Verify: The verify command allows you to test the integrity of 
StuffIt, StuffIt X, and Zip archives. If errors are encountered in 
the archive, StuffIt Deluxe will prompt you to before attempting 
to recover them.

The items available in the View menu allow you to change the sort order of 
the list in the foremost archive window.

The functions available in the Archive menu can be used to add and extract 
files from an open archive, as well as to access advanced archiving features 
such as comments or return receipt.

• New: The command will cause the StuffIt Deluxe application to 
create a new empty archive. You can have up-to nine archives 
open at the same time in the StuffIt Deluxe application.

• Stuff: The Stuff command (also accessible from the Archive 
menu) provides an alternative to drag and drop when it comes 
to adding files to an existing archive. When the Stuff menu item 
is clicked, a dialog prompts you to select the files that should be 
added to the current archive.

• UnStuff: The UnStuff command provides an alternative to drag 
and drop when it comes to extracting files from a StuffIt 
archive. The UnStuff menu item becomes active when an 
archive is open and items are selected. When clicked, a dialog 
prompts the user to select a location to which the selected items 
should be expanded.

• New Folder: The New Folder menu item allows the user to cre-
ate a New folder in the current archive.

• Delete: The Delete menu item is active when an archive is open 
and items are selected. The selected items are deleted from the 
archive when the menu item is clicked. The items are immedi-
ately deleted, rather than being moved to the Mac OS trash can.

• Get Info: The Get Info menu item is active when an archive is 
open and items are selected. When used, an Info dialog is 
opened for the selected item. This dialog functions in much the 
same way as the Get Info dialog in the Finder. The dialog dis-
plays information about the size, and modification date of the 
file, and also allows the user to view and edit its Type and Cre-
ator code. 

• Launch: The launch button allows you to UnStuff and launch 
or open a file in a single step. This menu item is active when an 
archive is open and items are selected. 
The View Menu

The Archive 
Menu
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• Edit Comment...: Opens the Edit Comment dialog that allows 
you to edit or add an archive comment.

• Return Receipt...: Allows you to add, edit or remove a Return 
Receipt request.

The Translate menu allows you to create archives in all the formats that are 
supported by StuffIt Deluxe, but that cannot be directly browsed and 
manipulated. These formats include LHa, Tar, Bzip, Gzip, Unix Compress, 
Apple Single, BinHex, MacBinary, and UUEncode.

The Scripts menu allows users to access the AppleScript features in StuffIt 
Deluxe.
 

• Open Script Editor: Launches Apple's Script Editor applica-
tion.

• Open Script Dictionary: Displays the AppleScript dictionary 
for StuffIt Deluxe.

• Open Scripts Folder: Opens the folder used to store StuffIt 
Deluxe scripts.

StuffIt Deluxe allows you to add Return Receipt requests to your StuffIt 
and StuffIt X archives. A Return Receipt request is used to ask the person 
receiving your file to let you know that they were able to expand the 
contents successfully. A Return Receipt Request includes your name, E-
mail address, and a message to your recipient. 

To add a Return Receipt Request to an archive that is open in the StuffIt 
Deluxe application:

1. Choose “Return Receipt -> Add” from the Archive Menu.
2. When prompted to do so, enter your Name, E-mail Address, 

and a message.
3. Click OK to add the Return Receipt request to your archive.

To edit an existing Return Receipt request:

1. Choose “Return Receipt -> Edit” from the Archive menu.
2. Modify the information in the Name, E-mail, and Comments 

fields.
3. Click the OK button.

To Remove a Return Receipt Request:
The Translate 
Menu

The Scripts Menu
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1. Choose “Return Receipt -> Remove” from the Archive menu.
2. Review the information, and click “Confirm”.

When you open an archive that contains a Return Receipt request, the 
StuffIt Deluxe application will display a dialog providing information 
about the Return Receipt.

When you see a Return Receipt request, the following options are 
available:

• Save: Saves the Return Receipt message as a text file so that 
you can read it later.

• Delete: Deletes the Return Receipt request from the archive.
• Ignore: Dismisses the dialog. No action is taken. The Return 

Receipt request will be displayed the next time you open or 
expand the archive.

• Respond: Creates a new E-mail message that is addressed to 
the sender.

The StuffIt Deluxe application allows you to add comments to your 
archives.

To add a comment to an archive open in the StuffIt Deluxe application:

1. Choose “Comment->Add Comment” from the Archive menu.
2. In the text entry field provided, add your comment.

To edit a comment:

1. Choose “Comment->Edit” from the Archive menu.
2. Edit the text in the comment field.
Responding to a 
Return Receipt 
Request

Comments
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You can get information about any of the files in a StuffIt archive by 
selecting the file, and clicking the Get Info button on the StuffIt Deluxe 
toolbar.

In addition to information about the name, size, and dates of creation and 
modification, the StuffIt Deluxe Get Info window also allows you to view 
and edit the Type and Creator of the file.

Note: Type and Creator codes are used by the Mac OS to link docu-
ments to their creating applications. Only change the Type and 
Creator codes for a file if you’re SURE you know what you’re 
doing!

Just as you can assign comments to the archive as a whole, StuffIt Deluxe 
also allows you to assign comments to individual files in the archive using 
the Comments field in the Get Info window.

This topic is designed to provide information about the StuffIt Deluxe 
preferences dialog. It covers the effect of all the available settings. The 
StuffIt Deluxe preferences dialog is divided in pages, each page is 
represented by an icon in a toolbar that runs across the top of the 
application. To switch pages, simply click the icon that corresponds to the 
page you want to view.

The General Page contains settings that effect the general operation of the 
StuffIt Deluxe application.
The Get Info 
Window

StuffIt Deluxe 
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• Allow Version Checking: The preferences governs whether the 
StuffIt Deluxe application will check for updates when it is 
launched. Using Version Checking requires that you have an 
available Internet Connection.

• Convert Old Archives on Open: When this check box is 
checked, older StuffIt archives will be converted to StuffIt for-
mat. This setting applies to any StuffIt archive created by a ver-
sion of StuffIt Deluxe prior to 5.0.

• Number of Recent Items: This toggle menu allows you to 
specify the number of archives that will be displayed in the 
Recent Items menu item in the StuffIt Deluxe application.

• Default Archive Name: This preference allows you to specify 
the default name that will be given to a new archive created by 
StuffIt Deluxe. The file extension for the currently selected file 
format will be appended to the name you select.

• Default Archive Type: This toggle menu allows you to deter-
mine the archive format that StuffIt will use when you select the 
New Archive command. The StuffIt Deluxe application sup-
ports StuffIt, StuffIt X, and Zip archives.

The Settings in the Compression page are used to control how files are 
compressed into archives.

• Compression Level: As well as changing the format in which 
the archive will be created, you can also change the 
Compression
Chapter 7: The StuffIt Deluxe Application - 47



StuffIt Deluxe 8.0 Users Guide
compression level that will be used when items are added to the 
archive. The choices are “Faster” and “Better”; as the names 
suggest the “Faster” compression method makes archives more 
quickly, and the “Better” compression method creates smaller 
archives. An addition choice, “Custom” is also available. When 
“Custom” is selected you can use the Advanced Compression 
Preferences dialog to determine how StuffIt Deluxe will 
compress your files. See “Chapter 15: Expert Compression 
Settings” on page 88 for details.

• Don't Compress Files that are Already Compressed: When 
checked, this preference means that StuffIt will not attempt to 
compress files that contain already compressed data when add-
ing them to an archive. Examples of files that contain already 
compressed data include .Gif and Jpeg images, MP3 music 
files, as well as other archive file types.

• Encrypt archives with a password: When this preference is 
set, StuffIt Deluxe will encrypt items added to an archive with a 
password. 

• Ignore Finder Desktop Files: When this preference is 
selected, StuffIt Deluxe will not add Finder files (such as the 
desktop database files) to an archive.

• MacBinary: The preference determines how Macintosh files 
that contain Resource forks will be treated when they are added 
to Zip archives. As the Zip format does not support Mac 
resource forks, they have to be MacBinary encoded to ensure 
that they will be preserved. When the toggle menu is set to 
Smart, files added to a Zip archive will only be MacBinary 
encoded when StuffIt Deluxe detects that they contain a 
resource fork.

Note: When you pick a MacBinary option, be aware of who will end 
up using your files. If you use MacBinary encoding and send the 
resulting Zip archive to a Windows user, they will most likely 
encounter problems when trying to unzip the contents. By default, 
we assume that you are zipping file because you want to send them 
to Windows users, and therefore the MacBinary preference is set to 
Never by default. The vast majority of Macintosh files are usable 
without there resource forks, so even if Mac users open zip archives 
created without MacBinary encoding, they should not encounter a 
problem using the files contained.

Expansion Destination: This preference determines where files will be 
placed when they are expanded from an archive. 
 

• Same as Original: The file will be expanded to the same loca-
tion as the archive file.
Expansion Prefs
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• Ask: You will be prompted to select a destination for the files 
being expanded.

• Use Specified: Use the Select button to specify a folder on your 
hard drive to use every time you expand files from an archive.

• Scan for Viruses Using: Using this preference, you can specify 
that files extracted from an archive are scanned for viruses 
using your Virus protection software. Use the toggle menu to 
select your Virus program, Norton AntiVirus, Virex, and Virus 
Barrier are supported.

The Views page allows you determine what columns will be displayed in 
the archive window.

• Kind: Displays the Kind Column in the StuffIt Deluxe applica-
tion.

• Label: Displays the Label Column in the StuffIt Deluxe appli-
cation.

• Date: Displays the Date Column in the StuffIt Deluxe applica-
tion.

• Expanded Size: Displays the Expanded Size Column in the 
StuffIt Deluxe application.

• Compressed Size: Displays the Compressed Size Column in 
the StuffIt Deluxe application.

• Percent Saved: Displays the Percent Saved Column in the 
StuffIt Deluxe application.

• Show Invisible Files and Folders: Determines whether invisi-
ble files and folders located in your archives are displayed in 
the archive window.

The Toolbars page allows you to configure how the StuffIt Deluxe toolbar 
will look and behave.

• Toolbar Orientation: This allows you to specify whether the 
toolbar is aligned vertically or horizontally.

• Toolbar Icon Size: Choose either large or small icons. Large 
icon view is used in the example shown above.

• Anchor Toolbar to top of screen: When checked, the StuffIt 
Deluxe toolbar becomes fixed to the top of the screen.

• Show Names: This setting determines whether or not the name 
of each button will be displayed in addition to the icon.

StuffIt Deluxe allows you to work with the files inside an archive just as 
easily as you can work with files inside of a folder. If you have a folder full 
Views Prefs

Toolbar
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of files that you do not use regularly, consider compressing them into a 
StuffIt archive. When you want to use one of the file, double click the 
archive to open it in the StuffIt Deluxe application, and browse through the 
folder to find the file you want to open. When you double click the file you 
want to use, you will be prompted to save that file out from the archive 
onto your hard drive. The file will then open in the application that created 
it, and will be ready to use. If you make modifications to the file, simply 
drag and drop it back into the archive.
Cool StuffIt 
Deluxe Tips and 
Tricks!
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Chapter 8: ArchiveSearch™
Use ArchiveSearch to search for files located in StuffIt, Zip, and StuffIt X 
archives in exactly the same way that you would use Sherlock to find files 
on your computer. If you’ve used StuffIt Deluxe to create backups of your 
important files, ArchiveSearch is an invaluable tool that makes it quick and 
easy to search those backups to find a specific file.

For more information on the basics of using ArchiveSearch, be sure to read 
“How Do I Search for files in an Archive?” on page 15.

ArchiveSearch is designed to provide the “look and feel” of the Find File 
section of Apple’s Sherlock application. You can search for files located in 
an archive using ArchiveSearch, in exactly the same way that you would 
search for files located on your hard drive using Sherlock. 

When you first launch ArchiveSearch, the user Interface provides you with 
options that allow you to look for files located in StuffIt, Zip, and StuffIt X 
archives on any local hard drive using the name of the file you are looking 
for. To start a search, simply enter the name of the file you want to find.

As with Searches conducted via Sherlock, the “Name Contains” need only 
contain part of the name of the file you are looking for. For example, if the 
file is called “StuffIt Deluxe” typing “Stuff” into the Name Contains field 
will return StuffIt Deluxe as a matching result.

As with Sherlock you can specify that a search for files use additional 
criteria to find a match.
Overview

Using 
Archive Search
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To add additional search criteria, click the More Choices button. Use the 
Toggle menu to select the criteria you want to use. You may search using 
all eight available criteria at once, or you can search using any combination 
you choose.

The additional choices are as follows:

• Name: Enter all or part of the name of the file you want to 
search for.

• Size: The size criteria can be used to search for files that are 
less than, greater than, or the same size as a specified value. 
When you select the size criteria, the second toggle menu in the 
list is used to set how size will be defined, and the text entry 
field is used to specify (in Kb) the size that will be used. The 
size that ArchiveSearch looks for is the original size of the file 
before it was compressed into the archive.

• Compressed Size: The Compressed Size criteria is configured 
in exactly the same way as the size criteria, except that 
ArchiveSearch will look for the compressed size of the file 
rather than the original expanded size.

• Kind: Use the Kind field to specify the kind of file you are 
looking for. You can specify the kind as alias, application, audio 
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file, clipping file, control panel, document, extension, folder, 
font, sound, stationary. You can also choose to find results 
based on whether files match the specified kind or not.

• Label: Use to find files based on whether they match (or don’t 
match) the specified label.

• Date Created: Use the Date Created criteria to match files 
based on whether their date of creation is within the range spec-
ified. Use the date field at to specify a target date, and use the 
toggle menu to specify whether matching files will be created, 
on, before, or after the date you have specified. The toggle 
menu also allows you to find files whose creation date is within, 
a specified number of days, weeks, or months, from the date 
specified. 

• Date Modified: The Date Modified criteria works in exactly 
the same way as Date Created, except that Archive search will 
look for files based on the modification date.

• File Type: Use File Type to find matching files based on their 
file type. File types are used under classic versions of the Mac 
OS to distinguish between different types of documents created 
by the same application, or to specify that a file is a specific 
type such as an application, a control panel, or an extension.

As well as changing the terms of the search using file based criteria, you 
can also specify the type of archives you want to search in, and the location 
you want to search for archives.

Use the “Search For” toggle menu to specify the type of archives to search. 
You can choose to search just for StuffIt archives, just for Zip archives, or 
just for StuffIt X archives. The default is to search for files located in all 
known archive types.

The location toggle menu allows you to limit the location that will be 
searched. You can set the search location to be any of the following:

• All Volumes: ArchiveSearch will search for files located in any 
archive attached to any volume that is currently available. This 
includes hard drives, network drives, CD ROMS and other 
removable devices.

• Local Unlocked Volumes: Use this choice to prevent 
ArchiveSearch from looking in Network drives and CD ROMS.

• Mounted Servers: Use this option to limit the search to just 
mounted network volumes.

• On the Desktop: Use this option to look for only files in 
archives located on the desktop.

• In the Finder selection: This option limits the search to only 
folders or archives selected in the finder.
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• Open in StuffIt Deluxe: Use this option to search only in 
archives that are currently open in the StuffIt Deluxe applica-
tion.

• In my Documents folder: Use this option to search for files in 
archives located in your documents folder.

• On a specific volume: ArchiveSearch also allows you to limit 
the search to only archives located on a specific volume. A list 
of all available volumes will be listed at the end of the location 
list.

Once you have specified search criteria you can save it to a file that can be 
used to set up a future search more quickly. To save you current search 
criteria, choose “Save Search Criteria...” from the File menu.

To load a previously saved search, choose “Open Search Criteria...” from 
the File menu, and select a saved search document when prompted to do 
so.

Once you have established your search criteria, click the “Search” button to 
begin searching for files. As ArchiveSearch is searching your hard drive, a 
progress dialog keeps you informed of its progress. The following fields 
are displayed;

• Archives Found: This field indicates how many archives 
ArchiveSearch has found in the specified search location.

• Archives Searched: This field indicates how many of the 
archives found have already been searched. This number, com-
pared to the number of archives found, will provide a rough 
indication of how much longer the search will last.

• Items Found: Indicates the number of matching archives that 
have been found.

You can stop the search at any time by clicking the “Stop” button.

When ArchiveSearch finds a matching item, the results window is 
displayed. The results window displays a list of all matching items, when 
you select a matching item the lower pane of the results window shows you 
where the matching file can be found. 

When you Control (ctrl) click on a matching file, ArchiveSearch provides a 
contextual menu that allows you to perform a variety of tasks.

• Close window: Closes the results window.
Saving Search 
Criteria

The Archive 
Search Progress 
Window

The Archive 
Search Results 
Window
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• Open Item: Extracts the selected item from the archive, and 
opens it. For applications, this will result in the application file 
launching, and for documents, the document will open in its 
parent application (if it is available).

• Reveal Item: Opens the archive that contains the selected file 
in the StuffIt Deluxe application.

• Expand Item: Expands the selected item from the archive.
• Expand to...: Expands the selected item from the archive. You 

will be prompted to select a location to which the file should be 
expanded.

• Expand to Desktop: Expands the selected item from the 
archive to the desktop folder.

• Expand to Document folder: Expands the selected item from 
the archive to the documents folder.

• Copy Item Name: Copies the name of the selected item to the 
clipboard.

You can also open any item in the results list by double clicking it. If you 
double click an item located within an archive, that item will be expanded 
and saved in the folder where the archive is located.

The ArchiveSearch preferences dialog allows you to specify the 
destination to which files expanded from an archive should be saved. 

• Same as original: Files will be placed to the same folder as the 
archive from which they are expanded.

• Ask: ArchiveSearch will prompt you to specify a location to 
which files are saved.
ArchiveSearch 
Preferences
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• Use Specified: Allows you to specify a single location to be 
used whenever files are extracted from ArchiveSearch.

You can use ArchiveSearch directly from within the StuffIt Deluxe 
applciation. Choose “Find” from the Edit menu to launch ArchiveSearch. 
When ArchiveSearch has been launched via StuffIt Deluxe, you can choose 
to limit your search to only those archives that are currently open in the 
StuffIt Deluxe application.

You can also limit a search to particular archive, or folder, by dragging and 
dropping the folder or archive onto the location toggle menu when 
ArchiveSearch is running.
Cool Archive 
Search Tips and 
Tricks!
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Chapter 9: Archive Assistant
Archive Assistant is a brand new part of the StuffIt Deluxe suite, and we 
hope you'll find it a valuable one. Before you use Archive Assistant, please 
take the time to review the information on this page. Our goal with Archive 
Assistant was very specific; we wanted to provide a backup application 
that was easy to use and that would allow you, the user, to organize and 
schedule the backup of all your important files and documents. The inter-
face of the product is designed to get you to that goal as quickly as possi-
ble, with the minimum possible interaction with the application. In short, 
we wanted Archive Assistant to be a fool proof backup option for anyone 
who doesn't like typical backup programs. If you're reading this with a 
sense of guilt about your current backup habits, this application is for you! 

This section is designed to get you through the process of creating and 
scheduling your first backup. Dialog by dialog, we'll explain exactly what 
you need to know about using Archive Assistant. 

To get started using Archive Assistant, launch the application from the 
StuffIt Deluxe folder in your OS X Applications folder. When you first 
launch Archive Assistant, you will see a dialog that lists all the various 
backup tasks you will create with the program. To get started adding a task, 
click the “New Task” button in the Archive Assistant toolbar.

Getting Started

When you click the “New Task” button on the tool bar, the Archive Assis-
tant “New Task” assistant is opened. This wizard style interface will walk 
you step by step through the process of selecting what to backup, where to 
create the backup archive, and when the backup task should be run. The 
first dialog, however, simply asks you to pick a name for the backup task 
you are about to create. The options button allows you to set some 
advanced options, but we recommend that you leave those alone for right 
now. When you've picked a name, click the “Continue” button to move to 
the next step. You can also use the “Cancel” button to exit the assistant, or 
the “Help” button to access information specific to the page you are on at 
any step in this process. 
About Archive 
Assistant

Using Archive 
Assistant

The Backup 
Assistant
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What to Backup

Archive Assistant is designed to be easy to use. When picking files to 
backup, the default option will simply backup all the files in your Home 
folder. In Mac OS X any data that you have created while using your com-
puter will be stored somewhere in your Home directory. For example, the 
files in your Documents folder and the files on your desktop will all be 
backed up if you choose the default option, as will all your bookmarks and 
preferences. If your not sure which option on this page is right for you, use 
the default. If you know that you don't need to backup all the information 
in your user folder, you can choose among various sub-folders stored in the 
Home folder.

Choose a Location for the Backup Archive

The pop-up menu at the top of the destination page lists the various options 
that you can select as a destination to which your backup archive will be 
saved. You can choose to backup to your current hard drive (although this 
isn't recommended), you can choose to backup to recordable CD's and 
DVD's, you can choose to backup to an FTP server, and you can choose to 
backup to an external hard drive (such as an external fire wire drive). 

If you backup to CD's and DVD's, you need to be aware that the size of 
your backup archive will likely exceed the size of a standard recordable 
CD. StuffIt has a great solution to this problem, and will automatically 
break your backup archive into pieces small enough to fit on your media. 
StuffIt will also automatically reassemble these pieces if you ever need to 
restore from your backup. Do remember, however, if you are backing up to 
CD you will need to be near the computer to insert additional CD's as and 
when they are needed. 

Perhaps the most convenient option is to backup to an external hard drive, 
such as a FireWire hard drive. If you choose this option, you can schedule 
your backup to occur late at night or over the weekend when you don't need 
to use your computer. You can tell StuffIt which drive your want to backup 
to simply by dragging and dropping your drive's icon into the indicated 
window. 

Tip: Did you know that your iPod can also be used as a Firewire hard 
drive? Drag and drop your iPod icon to the area indicated to select it as a 
backup destination. 

If you backup to an FTP server, you'll need to know the exact URL to the 
folder on the FTP server you want to backup to, and you'll also likely need 
to provide a user name and password to logon. Ask the person who admin-
isters the FTP server if you need to get this information. 
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Using a Date and Time Stamp

When you create a backup archive with Archive Assistant, you can choose 
to add a date and time stamp to the end of the archive name when it is cre-
ated. This is useful if you anticipate storing several archives created from 
the same task in a single location. The date and time stamp uses the follow-
ing format yyyymmdd-hhmmss; the year is listed first, then the month, 
then the day, then the hours, minutes and seconds. 

Note: If you do not use the date and time stamp, Archive Assistant will 
automatically replace older backup archives created from a task if they 
already exist in the specified destination.
 
Scheduling the Backup

You can choose to have Archive Assistant automatically run your backup 
task on at a specific time every day, or you can choose the days of the week 
on which the backup task will run. Remember, that if you choose to have 
the backup task run at a time when you will not be present at your com-
puter (such as late at night, or over the weekend) you will need to make 
sure that the destination you specified in step 4 will be available at that 
time and that it has enough free space in which to save your archive. Using 
an external hard drive or a remote server as a backup destination is the best 
way to do this. 

Even if you are able to choose a backup destination that will enable you to 
schedule a backup in the middle of the night, make sure that you remember 
to leave your computer running! Archive Assistant cannot run a scheduled 
backup task if your computer has been turned off.

Summary

The final page of the assistant provides a summary of the information you 
have provided. if you need to change any of the information, you can use 
the “Go Back” button to return to a previous page. 

When you exit the wizard you will now see the backup job you just created 
displayed in the list. There are various ways in which you can work with 
the backup task you have just created. 

You can edit the name of your backup task by double clicking its name. 
You can see when your backup task was last run by looking at the value in 
the “Last Run” column. You can see the date when the backup task is due 
to run next by looking in the “Next Scheduled Run” column. 
Working with 
Backup jobs
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You can choose to run a backup task at any time by selecting it from the list 
of tasks and clicking the “Run Task” button on the toolbar. Clicking the 
“Run Task” button will not alter the schedule that was previous assigned to 
the task. 

You can edit the details of a previous created backup task by selecting a 
task from the list and clicking the “Edit Task” button on the toolbar. Rather 
than using an assistant interface, you can edit the details of your task in a 
tabbed dialog. This will allow you to jump directly to the page you want to 
edit, without having to click through the ones you want to leave alone. 
Each tab in the dialog corresponds to a page in the assistant we used to cre-
ate the backup task. 

You can remove a task from the list by selecting it and clicking the 
“Delete” button. 

When you create a backup archive with Archive Assistant, you are creating 
an archive using the new StuffIt X file format. Because the archives you 
create are StuffIt archives, you will have a great deal of flexibility in choos-
ing how to access the files that have been backed up. You can work with a 
file created by Archive Assistant in the same way as you can work with any 
archive created by StuffIt Deluxe. See the chapters on StuffIt Expander, 
ArchiveSearch, and StuffIt Deluxe included in this Users Guide for more 
information.
Restoring from a 
backup archive
Chapter 9: Archive Assistant - 60



StuffIt Deluxe 8.0 Users Guide

Chapter 10: StuffIt Backup -  61

Archive Via Rename is a unique feature of StuffIt Deluxe that allows you 
to compress files and folders into an archive simply by adding the file 
extension of the archive to the end of the file or folder name.

For example, let’s say that there is a file called “Meeting Notes.txt” on my 
desktop. Using Archive Via Rename, I can compress that file into a StuffIt 
archive simply by adding “.sit” to the end of the file name. When the 
rename has been completed, the file will be compressed into a StuffIt 
archive called “Meeting Notes.txt.sit”.

You can also use Archive Via Rename to expand archives by removing the 
archive extension from the end of the file name.

For example, let’s say that I have an archive called “Pictures.sit” on my 
desktop. I can expand this archive simply by removing the “.sit” extension 
from the end of the archive file name. Once the rename has been com-
pleted, StuffIt will expand the archive and place the expanded files in a 
folder on your desktop.

Important Note!: Unlike other components of StuffIt Deluxe, Archive Via 
Rename acts directly on the file or folder you are renaming. This means 
that when you change the name of a file, such as “Meeting Notes.txt”, the 
file you rename is REPLACED by the archive that is created. In the same 
way, when you expand archives by renaming them, the archive you rename 
is REPLACED by the expanded data.

By default, when you install StuffIt Deluxe, Archive Via Rename is turned 
off. You can turn Archive Via Rename using the System Preferences dia-
log. To open the System Preferences dialog, choose “System Preferences” 
from the Apple Menu.

To turn on Archive Via Rename, click the “StuffIt AVR” Preferences Panel, 
and click the “Start” button. To stop Archive Via Rename, click the “Stop” 
button in this same dialog.

In order to function correctly, Archive Via Rename requires that you con-
figure Mac OS X to always display the extension of your files. If Mac OS 
X is configured to hide extensions, Archive Via Rename will automatically 
switch Mac OS X so that extensions are displayed.

About Archive 
Via Rename

Enabling Archive 
Via Rename
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Chapter 11: StuffIt Express™ Personal Edition
StuffIt Express is a utility that allows you to automate many different file 
transfer and compression tasks. The StuffIt Express application allows you 
to build custom “Express Boxes” that automate a specific sequence of 
tasks; for example you can use StuffIt Express to build an Express Box that 
creates an archive, and then uploads that archive to an FTP server.

To launch StuffIt Express, Open the StuffIt Deluxe application folder and 
double click on the StuffIt Express icon.

Use StuffIt Express PE for the following tasks:

• Compress and FTP in a single step
• Distribute files to a range of recipients
• Upload files to a web site
• Automate common file compression and transfer tasks

StuffIt Express PE is an application program that you can use to create your 
own personal drop boxes. A drop box is a special type of Macintosh 
application that preforms specific tasks to files and folders that are dropped 
onto its icon. These drop boxes can run any number of file compression 
and transfer tasks. You can use these drop boxes to automate file transfer 
tasks on your own computer, or you can create drop boxes to send to other 
people so that they can easily send you files over the Internet.

 Drop Boxes are created by adding tasks, or “Steps”, to a steps document in 
the StuffIt Express PE application. A steps document is a sequential list of 
all the actions that a drop box will perform. With-in Steps Document 
interface, you can easily create steps, change the order of steps, and delete 
steps as you create your drop box Each step contains all of the information 
needed to accomplish that part of the task. For example, when you create a 
step that will send a file by E-mail, you need to enter the E-mail address of 
the person to whom the E-mail will be sent, and the subject and message 
you want to send along with the file.

To add a step to an open steps document, you can either click the 
corresponding button on the steps palette, or choose the step you want to 
add from the New Step menu. To reorder steps, click and drag the step to its 
new position with in the document. The “Details” pane provides you with a 
summary of all the information that corresponds to the selected step, you 
Overview

Creating a Drop 
Box with StuffIt 
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can edit these details by double clicking the step from within the steps 
document.

When all the Steps required to automate a particular task have been 
specified, save the Steps document, and click the Create Drop Box button 
in the toolbar. This will create a Drop Box that performs all the tasks you 
have specified. Once a Drop Box has been configured, it can be modified 
through the Steps document. To edit an Express Box, open its steps 
document, make the necessary changes, and then click the Update Drop 
Box button in the toolbar.

The StuffIt Express User interface consists of the following elements:

• Steps Document
• Steps Palette
• Actions Palette

The Steps document can best be described as a sequential list of all the 
actions that an Express Box will perform. The buttons and menus that 
appear around the Steps document are designed to make it easy for you to 
add and remove steps from the list, build an Express Box application based 
on the list, and update an existing Express Box by making changes to a 
steps document.

• Add Step Button: The Add Step button contains a list of all the 
steps supported by StuffIt Express. Choose a step from the list 
to add it to the steps document.
The StuffIt 
Express User 
Interface

The Steps 
Document
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• Drop Box Settings Button: Opens the Drop Box settings 
dialog that allows you to change settings that govern how the 
Drop Box will run. Click here to learn more about Drop Box 
settings.

• Create Drop Box Button: This button is used to create an 
Express Box application based on the steps document that is 
currently open. If you have not saved the Steps document you 
will be prompted to do so before the Express Box itself is 
created.

• Update Drop Box Button: This button is used to update an 
existing Express Box application. To make changes to an 
Express Box, you must open its steps document, make the 
necessary changes, and then click the Update Drop Box Button 
to update the Express Box application. If you have not already 
saved your changes to the Steps document you will be prompted 
to do so.

• Run Drop Box Button: This button has the same effect as 
clicking the Create Drop Box button, except that after the Drop 
Box has been created it will automatically be run.

• The Steps List: The Steps Document dialog contains a list of 
all the steps that are currently specified. You can edit the details 
of any of the steps by double clicking it. You can also reorder 
steps within a steps document; click and hold down the mouse 
button on the step you want to move until the insertion line 
appears, and then drag the step to its new position in the list.

• The Details Panel: Below the steps list is the Details panel. 
This Panel is used to display information about the step that is 
currently selected in the steps list.

The steps palette is divided into three tabs, one for File steps, one for 
Internet steps, and one for Action steps. Each tab contains buttons that are 
used to add a particular step to the Steps document. For example, the 
Internet tab contains an FTP Upload button which is used to add an FTP 
upload task to the steps document. For more information on the steps that 
are available on each palette, please check out the appropriate section 
below:

The Commands palette is divided into two tabs. The Commands tab 
contains buttons that are used to Create and Update Express Boxes. The 
Wizards Tab contains links to templates that allow you to create Express 
Boxes quickly and easily based on common tasks such as Zip and Send e-
mail.
The Steps Palette

The Commands 
Palette
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Select "Archive" to add a step that archives files. "Archive" allows you 
compress multiple files and folders together into a single compressed 
archive file. You can specify what information is archived, where the 
resulting archive is created, a name, and the type of archive such as StuffIt 
or Zip. See "What to act on" for details.

You can also choose to encrypt an archive to protect sensitive data, or 
delete the archive after it is successfully created. 

You can enter an Archive Name or leave this box blank to use a default 
name. Choose an archive type. StuffIt is the default. StuffIt files can be 
expanded on Macintosh, Windows, Linux, and Solaris using StuffIt 
Expander. Download the latest version of StuffIt Expander at http://
www.stuffit.com. Additionally, you can choose a self-extracting file for 
Macintosh or Windows. 

Select "Encrypt archive with password" to protect sensitive data in an 
archive. Write the password somewhere where you can find it later if 
needed.

WARNING: If you forget an archive's password, there is no way to 
recover the information or to modify the contents of the archive. 
Aladdin Systems cannot decrypt archives without the password. Be 
sure to remember your passwords or write them down and put them 
in a safe and secure place. Note that passwords are case-sensitive.
Archive Step
Chapter 11: StuffIt Express - 65

http://www.stuffit.com


StuffIt Deluxe 8.0 Users Guide
Select "Archive originals instead of aliases" to ensure that the original 
items are archived rather than their aliases. 

Select Encode to add a step that encodes files. Typically you'll encode files 
when sending them to a different type of computer or operating system. 
You can specify what format to use and whether files inside folders should 
be encoded. See  "What to act on" and  "Where to act" for details.

Choose an encoding type from the list. Next, if desired, select "Encode 
files inside folders" to encode files contained within folders. Choose "Use 
file name" if you are encoding only one file.

Select Expand to add a step that expands archives, placing the contents in 
the location you specify. You can specify what is expanded, where the 
resulting files are placed, whether files in folders are expanded, and which 
files get deleted after expansion. See  "What to act on" and  "Where to act" 
for details.

Choose one or more of these options as desired. Select "Expand files inside 
folders" to expand the contents of folders contained in the archive. Choose 
one of the "Passing expanded items..." options to specify what result is 
passed to subsequent steps. This setting does not affect how the archive is 
expanded, merely what information is passed to the next step in the drop 
box. You can choose to pass both the folder structure and files to the next 
step, or pass only the resulting files without their folders.

Select New Folder to add a step that creates a new folder. You can specify 
where the new folder is created and the folder name. You can also specify 
to delete the folder when the drop box completes all of the tasks. See  
"Where to act" for details.

Folder Name: Enter a name for the folder or use the default. 

Select Copy Items to add a step that copies items. For example, you may 
create an Express Box that copies items to another location as a back up. 
You can specify which items to copy. See  "What to act on" and  "Where to 
act" for details.

Select "Replace items with same names" to automatically replace items 
with the same
names.
Encode Step

Expand Step

New Folder Step

Copy Items Step
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Select Move Items to add a step that moves items. You can specify what is 
moved, where the resulting files are placed, whether files in folders are 
replaced, and whether moved items are deleted once all of the drop box 
tasks are complete. See  "What to act on" and  "Where to Act" for details.

Choose one or more of these options as desired. Select “Replace items with 
same names” to automatically overwrite existing files with the same names 
without prompting.

Select Open/Launch Items to add a step that opens or launches files. For 
example, you can create a drop box that sends a group of images, then 
launches an application to edit them. Or you can send a spreadsheet and 
then open the application, assuming it is present on the system running the 
drop box. To specify what items to open or launch, select an option from 
the list. See  "What to act on" for details.

Select Make Alias to add a step that creates an alias. For example, you can
create a drop box that opens an archive, expands a file, and puts an alias to 
that file on the desktop. You can specify for what to create an alias, where 
the alias is placed and whether the alias should be deleted when all of the 
drop box tasks are completed. See “What to act on” and “Where to act” for 
details.

Select Rename Items to add a step that renames files. You can specify what 
items to rename. See  "What to act on" for details.

Enter a new name only if you are renaming one item. Select "Keep existing 
name's extension" to keep the current file's extension.

FTP stands for file transport protocol and is a protocol used to send files to 
or retrieve files from another computer on the internet. Select FTP Upload 
to add a step that uploads files via FTP. You can specify what to upload and 
the destination. You can also specify a user name and password. Be sure to 
specify whether existing items should be replaced. See  "What to act on" 
for details on specifying what to upload. 

FTP URL: Enter the URL of the FTP site. 

Tip: To place a file into a directory, the URL must end with "/" oth-
erwise, the address is assumed to specify a file or folder that should 
be replaced. For example, if you specify www.aladdinsys.com/
Move Items Step

Open/Launch 
Items Step

Make Alias Step

Rename Items 
Steps

FTP Upload Step
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uploads/ the file would be placed into the uploads folder. However, 
if you entered www.aladdinsys.com/uploads (and notice there is not 
a "/" at the end) as the URL, the "uploads" folder would be 
replaced with the file you send. If you do not have rights to upload 
to a location, you will receive an error message when you run the 
drop box. 

If you are trying to replace existing items on a server, and file or folder 
names (on your local disk and on the server) have special characters in 
them such as the less than character (<), space, forward slash, colon, 
percent, and any high-ASCII characters (greater than 255), you need to 
encode those characters. To encode a character, use %xxx where x is hex 
value of the character.

User Name and Password: Provide the user name and password if needed. 
If you are logging onto an anonymous FTP site, you may need to enter 
anonymous as your name and your e-mail address as your password.

Select “Replace existing items at this URL” to automatically overwrite 
existing files with the same name. If you are uploading to a site with a 
firewall, you may need to select “FTP Passive Mode” setting depending on 
how the firewall is configured. Try sending with each of the options 
selected. Contact the administrator of the ftp site if you are unsure.

Select FTP Download to add a step that downloads files via ftp. You can 
specify where to download files such as a downloads folder, or see  "Where 
to act" for descriptions of the other options.

FTP URL: Enter the URL of the ftp site. See  "FTP Upload" above for 
details on specifying the path and file name.

User Name and Password: Provide the user name and password if needed.

Select "Replace existing file or folder" if you want to automatically 
overwrite existing files with the same name. If you are downloading from a 
site with a firewall, you may need to select a "FTP Passive Mode" setting 
depending on how the firewall is configured. Try sending with each of the 
options selected. Contact the administrator of the ftp site if you are unsure.

Select HTTP Download to add a step that downloads files via http. You can 
specify the download destination such as a downloads folder. See  "Where 
to act" for descriptions of the other options.
FTP Download 
Step

HTTP Download 
Step
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HTTP URL: Enter the URL of the http site. You can specify "http://" or 
"https://" but be sure that the name specifies a file, and not a folder. There 
should not be a "/" at the end of the line. See  "FTP Upload" above for 
details on specifying the path and file name.

User Name and Password: Provide the user name and password if needed. 
Select "Replace any existing file" if you want to automatically overwrite 
existing files with the same name.

Select Open URL to add a step that opens a specific URL in your web 
browser. Enter the address of the URL to open. See  "FTP Upload" above 
for details on specifying the path and any special characters.

Select Send E-mail to add a step that e-mails files. You can specify one or 
more recipients, the subject and message text, and specify whether to send 
immediately. StuffIt Express uses AppleScript to send E-mail using one of 
the following E-mail clients: Mail.app (Mac OS X E-mail client), Eudora, 
and Entourage. When the drop box runs, it will obtain the information it 
needs from your e-mail client to send the message. Your computer must be 
set up to use e-mail to use this feature.

What to E-mail: See "What to act on" for details. You can also choose 
"Nothing" to create a message without an attachment.
Open URL Step

Send Email Step
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Recipients: Click Add, then enter the name and address of each recipient. 
In the Type box, specify To, CC, or BCC. "To" sends a message to a 
recipient, CC or "carbon copy" sends a copy of the message listing the 
other recipients, and BCC stands for "blind carbon copy", and means to 
copy the person without the other recipients seeing that person's name on 
the list. To remove anyone on the list, select that name, then click Remove. 
As you start typing an e-mail address, StuffIt Express tries to match the text 
being typed to addresses that have previously been entered in this dialog 
box. A floating window displays with most frequently-used matching 
address highlighted; you can select that address by double-clicking the 
address, or by pressing Enter. Select additional addresses the same way. As 
you continue to type, StuffIt Express removes any addresses that no longer 
match. When no addresses in the book match the address you have entered, 
the address book window is removed.

Click "Recipients" to force the drop box to ask for recipients when the drop 
box runs.

Message Settings: Enter a subject and an optional message. If you want the 
name of the attachment to display in the subject, type "^A" to include the 
name. In the message, type "^R" to display a list of most recent result items 
or "^D" to display a list of all dropped items in the message. You can also 
type "^" followed by a number to list the items resulting from a specific 
step number in the steps document. Select the check boxes "Allow editing 
of" to specify additional options. Choose "Subject and message" if you 
want to be prompted for a subject and message each time you run the drop 
box. You might choose this option if you have created a drop box that 
allows you to quickly send messages to someone you frequently 
correspond with. choose "Recipients" to edit the list when the drop box 
runs rather than during creation. Choose "Substitute full path names" to use 
the path to the original file. Choose "Include sender as recipient" if you 
would like a copy of the message sent to the person using the drop box. 

Select "Send Immediately" to send the message when the drop box is used.

Select Stop StuffIt Express to add a step that stops a drop box. For 
example, if you provide a dialog box that asks if the user wants to continue, 
and they choose No, use this step to quit the drop box. If they choose Yes, 
you can skip one step (the Stop step) and continue running the drop box.

Message: Enter an optional message here that will display when this step is 
encountered. If no message is specified, the drop box will stop and display 
a dialog box.
Stop Drop Box 
Step
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Choose Edit > StuffIt Express Settings or click the StuffIt Express Settings 
toolbar button to display the drop box settings dialog.

• Author and Description: The Author text is filled in with the 
name entered when StuffIt Express was installed. You can 
change this if needed. You can also add an optional description. 
You may want to include the name of the drop box, how to 
contact you, a version number, a description of what it does, or 
other information indicative of its contents. The author and 
description displays in the About box of the drop box you 
create. 

• StuffIt Express E-mail Signatures: By default, a special 
StuffIt Express signature is added to any e-mail message that is 
sent from a StuffIt Express Drop Box. Uncheck this box to stop 
this signature from being used.

• Include DropBox in the StuffIt Contextual Menu: You can 
make your StuffIt Express DropBoxes available in the StuffIt 
Contextual menu, under the DropBoxes Submenu. When you 
create a DropBox with this option set, an alias that points to it 
will be created in the Library/Application Support/StuffIt CM 
DropBoxes folder in your User folder. When you Control 
[CTRL] click a file in the Finder, and choose a DropBox from 
the DropBoxes menu, the DropBox will treat the selected file as 
if it had been dragged and dropped onto the DropBox icon.

Tip: To remove a DropBox from the StuffIt Contextual menu, simple 
open the Library/Application Support/StuffIt CM DropBoxes folder 
in your User folder and delete the alias of the DropBox you wish to 
remove.

Run Options: You can configure whether the drop box operates manually 
or automatically. When one of the automatic options is chosen, the drop 
box runs without user interaction once a file is dragged onto it.

• Manual: The Steps window is visible, and the person using the 
drop box must click "Start"

• Automatic: The Steps window is only shown if an error occurs

Note: The steps window displays a list of the actions that the drop 
box will perform. If the drop box encounters a problem, the result-
ing error message is displayed in the steps window.
Drop Box 
Settings
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There are a number of options that are common to most of the steps 
available in StuffIt Express. These options allow you to specify the item a 
step action is performed on and where any output is created.

• What to act upon: "Dropped items" means the step will start 
when items are dropped onto the drop box. "Most recent result" 
uses the results of the last step that produced a file. "Ask for 
items" displays a dialog box prompting for the files to be acted 
upon. Once items have been selected, the step starts. "Result of 
prior step" uses the results from a previous StuffIt Express step. 
Note that this option is only available when a previous step 
could result in files to act upon. Examples of what to act upon 
include what to archive or what to upload.

• Where to act: This specifies the destination folder for items 
created using a drop box. "Same as original" means the same 
location as the original item dropped on the drop box. "StuffIt 
Express's folder" means the folder where the drop box is 
located. "Ask" displays a dialog box that prompts for a 
destination. "Result of New Folder step" is only enabled if a 
previous step creates a new folder. "Special Folder" allows you 
to specify an OS-related folder such as System. Choose 
"Specific Folder" to specify that folder. Click the Choose Folder 
button and navigate to the folder you want to use. If the 
specified folder is not available, the person using the drop box 
is prompted to specify a new location. Examples of where to act 
include where to archive or where to download to.

StuffIt Express is also available in an Enterprise Edition for Macintosh and 
Windows. StuffIt Express Enterprise helps you to smooth communication 
between you and your customers. Create a drop box for your clients to use 
every time they have to send you files. StuffIt Express Enterprise drop 
boxes can be freely distributed to as many customers as your license 
allows.

StuffIt Express for Enterprise contains these additional features:

• Forms: StuffIt Express forms allow you to use an Express box 
to collect information from your customers. As they send files, 
the Express box can require them to provide information to be 
sent to you at the same time as the documents.

• Multi Media Steps: StuffIt Express Enterprise includes steps 
that allow you to embed sounds, pictures, text, and even movies 
in your Express Box. Use the Multi Media steps to create an 
What to Act Upon 
and Where to Act

StuffIt Express 
for Enterprise
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Express box that presents a big company branded look and feel 
on a small company budget.

• AppleScript: StuffIt Express Enterprise allows you to extend 
the functionality of your drop boxes using AppleScript. StuffIt 
Express can execute an AppleScript along with its typical file 
compression and transfer tasks.

• Distribution: StuffIt Express Personal Edition only allows you 
to run your Express Boxes on the machine on which they were 
created. StuffIt Express Enterprise is designed specifically to 
allow you to distribute Drop Boxes to your customers, co-
workers, and outside partners.

If you would like more information about StuffIt Express Enterprise, 
including information about obtaining a license, please contact Aladdin 
Sales at (831) 761-6200.
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Chapter 12: StuffIt CM and Magic Menu™
The StuffIt Contextual Menu™ (or StuffIt CM) provides a quick and easy 
way to access all the functionality of the StuffIt Deluxe package directly 
from the Finder. You can create and expand archives and encoded files, and 
you can also browse through the contents of an archive to extract single 
items. The StuffIt Contextual menu also allows you to Stuff and send files 
via E-mail in a single step. You can also access the various function of the 
StuffIt contextual menu from the Magic Menu, which is displayed in the 
Finder’s menu bar.

Using the StuffIt Contextual menu is easy! Simply Control (Ctrl) click the 
file you want to compress (or expand) and choose the action you want to 
perform from the “StuffIt” menu.

Tip: Invest in a two button mouse! When you use a two button 
mouse, right clicking on a file will have the same effect as using the 
Control [CTRL] click combination.

When you control click on a file or folder, the StuffIt Contextual menu 
allows you to access the following functions:

• Stuff: By default, the Stuff command will create a StuffIt 
archive that contains the items that are currently selected in the 
Finder. You can also configure the Stuff command to create 
StuffIt X archives via Menu Preferences (see below).
Overview

Using the StuffIt 
Contextual Menu

Available Actions
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•Archive: The archive 
menu provides you with 
the option to create 
archives, from the items 
currently selected in the 
Finder, in a wide variety 
of formats. You can create 
Zip, Tar, and Lha archives 
using the Archive 
command, and you can 
also choose to further 
compress or encode these 
archives so that you end 
up with, for example, a 

Gzip compressed Tar archive.
• Compress: The Compress menu allows you to compress single 

files selected in the Finder using Gzip, Bzip, and Unix Com-
press compression.

• Encode: The Encode menu allows you to encode single files 
selected in the Finder using MacBinary, BinHex, AppleSingle, 
and UUEncode formats.

• Make Self-Extracting: The Make Self-Extracting menu allows 
you to compress files into a StuffIt archive and make that 
archive self-extracting for either Macintosh or PC.

• Segment: Use the Segment menu option to segment large files 
into small pieces. The size of the segments that will be created 
can be set in the StuffIt Menu Preferences dialog.

• Mail: The Mail item allows you to create an archive and send it 
via E-mail in a single step. The Mail sub-menu lists all the 
available options so you can compress and mail an archive 
created in any of the formats that are supported by StuffIt.

• Drop Boxes: The Drop Boxes menu option allows you to send 
the selected files and folders to a StuffIt Express Drop Box that 
you created earlier.

Tip: When you create an Express Box application with StuffIt 
Express you can automatically choose to have StuffIt Express add 
the new drop box to your Drop Boxes menu.

• Preferences: Opens the StuffIt Menu Preferences dialog.

Note: All the actions that can be accessed via the StuffIt Contextual 
menu can also be used via the Magic Menu.
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Some of the items in the StuffIt Contextual Menu only appear when you 
Control click specific types of files.

When you Control Click an archive, compressed, or encoded file, the 
following menu item appears:

• Unstuff: This menu item causes the selected item to be 
expanded.

When you control click a StuffIt, StuffIt X, or Zip archive, an “Archive” 
menu appears along side the StuffIt menu in the Mac OS Contextual menu. 
The archive menu can be used to view the contents of an archive in 
hierarchical form. If you select an item from the folder structure the StuffIt 
Contextual menu will extract it from the archive.

When you control click a StuffIt or StuffIt X archive the following menu 
item appears:

• Add Return Receipt: This adds a Return Receipt request to the 
selected archive using the settings specified in the Menu Prefer-
ences dialog.

When you control click a StuffIt or StuffIt X archive that already contains a 
Return Receipt request, the following menu item is displayed:

• Remove Return Receipt: This menu items deletes the Return 
Receipt from the selected archive.

When you control click a self-extracting archive the following item 
appears:

• Remove Self-Extracting: This option allows you to turn a self-
extracting StuffIt archive into a regular archive.

When you control click a compressed Tape Archive, such as a .tgz file, the 
following option appears:

• Remove Compression: This option allows you to convert a 
compressed Tape Archive into a regular Tar file.

The StuffIt Contextual menu also allows you to browse the contents of an 
archive directly in the Finder. Browsing an archive allows you to view its 
contents, and extract files or folders without having to expand the entire 
archive.
Conditional 
Menu Items

Browsing 
Archives using 
StuffIt CM
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To browse an archive using StuffIt CM hold down the Control (CTRL) key 
on your keyboard and click the archive you wish to see inside. Beneath the 
StuffIt contextual menu, you will see a new menu item named for the 
archive you have selected. This new menu item will display a hierarchical 
menu that displays the contents of the archive.

The Magic Menu is a companion to the StuffIt Contextual menu. It allows 
you to access StuffIt CM functions from the Finder’s Menu bar. Magic 
Menu works in the same way as the StuffIt Contextual menu, and exactly 
the same range of functions are available. 

Magic Menu is compatible with Mac OS X 10.2, but there are a couple of 
extra steps necessary to install it. After you have run the main StuffIt 
Deluxe installer, logout of your user account and log back in again. After 
you have logged back in, open the StuffIt Deluxe install folder and double 
click the Magic Menu item. This will cause the Magic Menu to be loaded 
on your menu bar. By default, Magic Menu will now load whenever you 
log onto your computer.

Tip: To unload Magic Menu, hold down the Command key on your 
computer, and drag the Magic Menu item from your menu bar to 
the desktop. This will cause it to be unloaded. By default, once you 
have unloaded Magic Menu it will not load again when you log 
onto your computer. To reload Magic Menu, simply double click the 
Magic Menu item in your StuffIt Deluxe install folder.

When Magic Menu is loaded, you can also access StuffIt functions in the 
Finder using Command key short cuts. Use Command+S to compress files 
and folder that have been selected in the Finder, and use Command+U to 
unstuff archives, compressed, and encoded files that have been selected in 
the Finder.

The Menu Preferences dialog is used to set the behavior of both the StuffIt 
Contextual Menu and Magic Menu. To open the Menu Preferences dialog, 
choose Preferences from the menu.

The Expansion Prefs determine how the StuffIt Contextual menu will 
handle expanding archives and encoded files. 
Magic Menu in 
Mac OS X

StuffIt Hotkeys

Menu 
Preferences

Expansion Prefs
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• Expand Archives and Compressed Files: When this prefer-
ence is enabled, StuffIt Contextual Menu will expand archives 
and encoded files.

• Delete [archives and encoded files] after expanding: This 
preference is active only when Expand Archives and Encoded 
files is enabled. When it is enabled, the archives and com-
pressed files you expand will be deleted once the files they con-
tain are successfully extracted.

• Expand Encoded Files: Use this preference to determine 
whether or not StuffIt Contextual Menu should attempt to 
expand encoded file.

• Delete [encoded file] after expanding: This preference deter-
mines whether or not encoded files should be deleted after they 
have been expanded.

• Continue to expand (if possible): This preference, when 
enabled, causes StuffIt Contextual Menu to scan the file that 
results from expanding an archive, compressed, or encoded file 
to see if it can be further expanded. For example, when this 
preference is enabled, and StuffIt Contextual Menu encounters 
a BinHex encoded StuffIt archive, it will start to expand the 
archive as soon as it has decoded BinHex layer.

• Ignore Return Receipt messages: Causes StuffIt Contextual 
Menu to ignore Return Receipt messages in StuffIt archives. 
See “How Do I Add a Return Receipt request to an Archive?” 
on page 18 in chapter 2 for more information on how to add a 
Return Receipt message to an archive.

• Scan for Viruses: StuffIt Contextual Menu allows you to auto-
matically scan files that are extracted from archives and 
encoded files for viruses with your virus protection software. 
StuffIt Contextual Menu supports Virex, Norton Anti-Virus, 
and Virus Barrier.
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Compression Preferences determine how the StuffIt Contextual menu 
behaves when compressing files.

• Compression Level: As well as changing the format in which 
the archive will be created, you can also change the 
compression level that will be used when items are added to the 
archive. The choices are “Faster” and “Better”; as the names 
suggest the “Faster” compression method makes archives more 
quickly, and the “Better” compression method creates smaller 
archives. An addition choice, “Custom” is also available. When 
“Custom” is selected you can use the Advanced Compression 
Preferences dialog to determine how DropStuff will compress 
your files. See page 88 for details.

• Delete Originals After Stuffing: The original files that were 
compressed into the archive will be deleted from your hard 
drive when the archive is created.

• Stuff each Item as an individual archive: When this option is 
set, when select multiple items with the StuffIt Contextual 
Menu, each item will be compressed as an archive. The items 
will not be combined into a single archive file as they are com-
pressed.

• Encrypt Archives with a Password: When this option is 
checked, the archives you create will be encrypted with a 
password. You will be prompted to provide a password before 
the compression begins.

Note: When you create an archive with encryption, be sure to make 
a careful note of your password. Aladdin cannot recover files from 
encrypted archives if you have lost your password. Note that pass-
words are also case sensitive.

• Ignore Finder Desktop Files: When this option is set, StuffIt 
Contextual Menu will not add Finder files (such as Desktop 
Database files or .DStore) to an archive.

The StuffIt Preferences determine how the StuffIt Contextual menu will 
create StuffIt Archives

• StuffIt Archive Format: Choose whether the StuffIt Contex-
tual menu will create StuffIt or StuffIt X archives.

• Stuff and Mail Using: Choose the email program that will be 
used when you Stuff and Mail.

• Add Redundancy: Use this setting to choose whether StuffIt X 
archives are created with Error Correction. This option is not 
available when the StuffIt Archive Format is set to StuffIt X.
Compression 
Prefs

StuffIt Prefs
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Macintosh Resource forks are not supported by Zip, Tar, and Lha archives. 
In order to preserve Macintosh Resource fork information it is necessary to 
MacBinary encode these files before they are added to an archive. 

Tip: Just StuffIt! (Use StuffIt archives, that is.)

The MacBinary Preferences determines how this MacBinary Encoding is 
preformed.

• Never: Files will never be MacBinary encoded before they are 
added to a Zip, Tar, or Lha archive. Macintosh file information 
will be lost.

• Smart: By default, the MacBinary preference is set to Smart. 
This means that files that contain extended information (such as 
resource forks) will be encoded before they are archived, files 
that do not contain extended information will not be encoded 
before they are added to the archive.

• Always: This option will cause all files added to Zip, Tar, and 
Lha archives to first be MacBinary encoded, regardless of 
whether they contain extended file information.

The Segment Preferences are used to specify the size of the segments that 
StuffIt Context menu will create, and also to specify the location where
the segments will be created.

• Segment Size: The Segment Size toggle menu can be used to 
select one of the available pre-defined segment size choices. 
These pre-set options are designed to cover a range of popular 
backup media such as Zip disks, and CD ROMS.

Tip: You can set your own segment size by choosing “Other...” from 
the toggle menu. In the dialog provide enter (in Kb) the size of the 
segment you want DropSegment to create.

Disk Image preferences determines how StuffIt Contextual Menu will 
handle disk image files.

• Mount Disk Images: When this preference is enabled, StuffIt 
Contextual Menu will attempt to mount disk image files. 
MacBinary Prefs

Segment Prefs

Disk Images
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Note: StuffIt Contextual Menu is not able to mount .dmg disk image 
files created by Disk Copy under OS X. These disk images must be 
mounted with the Disk Copy application.

• Keep Mounted Images in RAM: When this preference is 
enabled, StuffIt Contextual Menu will keep the mounted disk 
image in RAM if there is enough free memory available. A disk 
image mounted in RAM has the same properties as a RAM 
Disk created under classic versions of the Mac OS.

• Mount images unlocked by default: When this preference is 
enabled, StuffIt Contextual Menu will attempt to mount disk 
images as unlocked (read/right) volumes.

Note: Images that include compression can only be mounted as 
locked volumes.

The Destination preferences allows you to specify where StuffIt Contextual 
menu should create files. Use this dialog to...:

• Specify where Expanded files should be created
• Specify where newly created archives should be saved.
• Specify where newly created segments should be saved.

The available choices are the same in all three cases.

You can choose the location where files are extracted. The following 
options are available:

• Same as Original: When this option is selected files will be 
created in the same folder as a) the archive they were expanded 
from b) the original files that were compressed or encoded c) 
the original file that was segmented.

• Ask: When this option is selected, StuffIt Contextual Menu will 
prompt you to specify a location in which files should be cre-
ated.

• Use...: Use this option to specify a location to be used every 
time StuffIt Contextual Menu saves a file.

You can also specify whether or not StuffIt Contextual Menu should place 
expanded files into a new folder.

• When the archive contains multiple items: When this option 
is selected, StuffIt Contextual Menu will create a surrounding 
folder whenever the archive contains multiple items at the root 
Destination Prefs
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level. The name of the archive will be used for the newly cre-
ated folder.

• Never: StuffIt Contextual Menu will never create a surrounding 
folder.

• Always: StuffIt Contextual Menu will always create a sur-
rounding folder.

StuffIt Deluxe allows you to add Return Receipt requests to your StuffIt 
and StuffIt X archives. A Return Receipt request is used to ask the person 
receiving your file to let you know that they were able to expand the 
contents successfully. A Return Receipt Request includes your name, email 
address, and a message to your recipient. 

The StuffIt Menu Preferences dialog allows you to pre-configure a Return 
Receipt request so that it can quickly be added to an archive. In the fields 
provided enter your Name, Email Address, and a message to be displayed 
to the user when they open the archive.

Allows each of the items in the StuffIt Contextual menu to be turned on and 
off. You can also choose to turn off the StuffIt Finder keyboard shortcuts.
Return Receipt 
Prefs

Menu Items Prefs
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Chapter 13: Other Drag & Drop Applications
DropSegment™ is used in the same way as DropStuff, except that rather 
than creating archives, it is used to split larger archives into smaller pieces.

Note: DropSegment can be used to split any file into smaller pieces, 
however, you’ll need to split your file into fewer pieces if you first 
compress it into a StuffIt archive.

To use DropSegment, simply drag and drop the file you want to segment 
onto the DropSegment icon, or the DropSegment application window. To 
Expand StuffIt Segments, make sure that all the segments are located 
together in a single folder, and the drag and drop segment number 1 
(file.sit.1) onto the StuffIt Expander icon. StuffIt Expander will then 
automatically rejoin the pieces of the segmented file and then expand its 
contents.

The DropSegment Preferences dialog is used to specify the size of the 
segments that DropSegment will create, and also to specify the location 
where
the segments will be created.

• Segment Size: The Segment Size toggle menu can be used to 
select one of the available pre-defined segment size choices. 
These pre-set options are designed to cover a range of popular 
backup media such as Zip disks, and CD ROMS.

Tip: You can set your own segment size by choosing “Other...” from 
the toggle menu. In the dialog provide enter (in kb) the size of the 
segment you want DropSegment to create.

• Show Drag Window: This option determines whether the drag 
and drop application window will be displayed when 
DropSegment is launched.

The settings in the Destination page where on your hard drive the new 
segments will be created.

• Same As Original: By default, DropSegment will create 
segments in the same location as the original files that were 
compressed.
DropSegment

Using 
DropSegment

DropSegment 
Preferences
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• Ask: This option causes DropSegment to prompt you to specify 
a location to which the segments will be saved.

• Use: This option allows you to specify a location on your hard 
drive to which all segments created with DropSegment will be 
saved.

DropConvert™ is a tool that allows you to batch convert older archives to 
the new StuffIt X format. To batch convert your archives, simply drag and 
drop them on top of the DropConvert icon, or onto the DropConvert 
application window.

The DropConvert preferences dialog allows you to specify whether older 
archives should be converted to StuffIt or StuffIt X archives. You can also 
specify what should happen to the archives that have been converted. You 
can choose to rename the older archives, move them to a back up location, 
or remove them from your computer. You can also use the Destination tab 
to specify where the newly converted archive should be created.

Secure Delete™ is a Drag and Drop application that allows you to remove 
files from your computer in such a way that they cannot be recovered even 
with special disk recover software.

Note: When you drag and drop files or folders onto Secure Delete 
they are IMMEDIATELY deleted from your hard drive. They are 
not moved to the trash, and you will not be able to undo the dele-
tion. Use Secure Delete ONLY when you are absolutely sure the 
files you want to delete must be securely removed.

When you delete files using Secure Delete, the application writes over the
section of the hard drive where the files were located 3 times, so that they
cannot be recovered.
DropConvert

DropConvert 
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Chapter 14: StuffIt Plug-Ins
This version of StuffIt Deluxe includes Add-Ins for Adobe Photoshop, and 
Illustrator, as well as Microsoft Word. The StuffIt Add-Ins allows you to 
compress your word documents directly into StuffIt archives, allows you to 
stuff and E-mail directly from within the Word application, and allows you 
to open  files directly from within StuffIt archives.

The StuffIt Plug-In for Photoshop requires at least version 7.0 of 
Photoshop, the Plug-In for Illustrator requires version at least version 10 of 
Illustrator, and the Word Add-In requires at least word X.

To install the StuffIt Add-In for word follow these steps;

1. Open the “Office Add-Ins” folder inside your StuffIt Deluxe install 
folder.

2. Drag the file “StuffIt Word X Add-In” to the “Office\Startup\Word” 
folder in your Microsoft Office X folder.

3. The next time you launch Word, the new StuffIt commands should be 
available in your File menu.

When the StuffIt Add-In is loaded, four new options will be available in the 
Word File menu;

• Save as StuffIt Archive: This command will compress the 
currently open Word document into a StuffIt archive. If the 
document contains unsaved changes, you will first be prompted 
to save those changes.

• Stuff and Mail: The currently open Word document is 
compressed into a StuffIt archive. That archive is then attached 
to a new mail message created using your default E-mail 
program.

• Open Archived Document: This command allows you to open 
a document from a StuffIt archive directly into the Word 
application.

Note: This command assumes that the archive you are opening 
contains only a single Word document. If the archive contains 
multiple documents, the first Word document that is encountered 
will be loaded.
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• StuffIt Preferences: Opens the StuffIt Menu preferences 
application, from which you can change settings for the Word 
Add-In.

To install the StuffIt Plug-In for Adobe Photoshop, follow these steps:

1. Open the “StuffIt Third Party Plug-Ins” folder inside your StuffIt 
Deluxe install folder.

2. Drag the file “StuffItPS” to the “Plug-Ins/Adobe Photoshop Only/
Automate” folder in your Adobe PhotoShop folder.

3. The next time you launch Photoshop, new StuffIt commands should be 
available in the “Automate” menu in the File menu.

When the StuffIt Plug-In is loaded, four new options will be available in 
the Automate menu:

• Save as StuffIt Archive: This command will compress the 
currently open Photoshop document into a StuffIt archive. If the 
document contains unsaved changes, you will first be prompted 
to save those changes.

• Stuff and Mail: The currently open document is compressed 
into a StuffIt archive. That archive is then attached to a new 
mail message created using your default E-mail program.

• Open Archived Document: This command allows you to open 
a document from a StuffIt archive directly into the Photoshop 
application.

Note: This command assumes that the archive you are opening 
contains only a single Photoshop document. 

• StuffIt Preferences: Opens the StuffIt Menu preferences 
application, from which you can change settings for the 
Photoshop Plug-in.

To install the StuffIt Plug-In for Adobe Illustrator, follow these steps:

1. Open the “StuffIt Third Party Plug-Ins” folder inside your StuffIt 
Deluxe install folder.

2. Drag the file “StuffItAI” to the “Plug-Ins” folder in your Illustrator 
folder.

3. The next time you launch Illustrator, new StuffIt commands should be 
available in the “Automate” menu in the File menu.
Installing the 
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When the StuffIt Plug-In is loaded, four new options will be available in 
the Automate menu:

• Save as StuffIt Archive: This command will compress the 
currently open document into a StuffIt archive. If the document 
contains unsaved changes, you will first be prompted to save 
those changes.

• Stuff and Mail: The currently open document is compressed 
into a StuffIt archive. That archive is then attached to a new 
mail message created using your default E-mail program.

• Open Archived Document: This command allows you to open 
a document from a StuffIt archive directly into the Illustrator 
application.

Note: This command assumes that the archive you are opening 
contains only a single Illustrator document. 

• StuffIt Preferences: Opens the StuffIt Menu preferences 
application, from which you can change settings for the 
Illustrator Plug-in.

The StuffIt Plug-Ins share a common settings file with Magic Menu and the 
StuffIt Contextual Menu. Settings made in the Menu Preferences applica-
tion will also effect the Word, Photoshop, and Illustrator 
Using the 
Illustrator Plug-
In
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Preferences
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Chapter 15: Expert Compression Settings
The information in this chapter is designed to provide an overview of the 
Expert Compression Settings dialog. This dialog provides an “Expert 
Mode” interface for setting the way in which the various compression 
methods supported by StuffIt Deluxe should be used. The dialog can be 
accessed from any StuffIt application in which the compression level to be 
used can be specified. When the Compression Level toggle menu is set to 
“Custom”, the values in the Advanced Compression Settings Dialog will 
be used.

The following formats support advanced compression settings:

• StuffIt X
• StuffIt
• Zip
• Bzip
• Gzip

The Advanced Compression Settings dialog can be access from the 
following applications:

• DropStuff
• DropZip
• DropTar
• Magic Menu
• StuffIt CM
• StuffIt Deluxe

Compression method allows you to select different compressors for use 
when adding files to a StuffIt X archive with compression. 

• Method 0 (No Compression): Files will be added to the 
archive without being compressed.

• Method 1 (Fastest Compression): Method 1 provides 
compression that is optimized for speed of compression and 
decompression. It works by replacing a series of bytes with a 
reference to a previous occurrence of the same series of bytes. 
Method 1 is used when the compression level is set to fast in 
Menu Preferences, DropStuff, or StuffIt Deluxe.

• Method 2 (Best Binary Compression): Method 2 is optimized 
for the compression of binary files (such as applications) and 
Overview
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also for fast decompression. Method 2 works in the same way 
as Method 1, except that it has a more exact way of representing 
the offsets and lengths, which makes it compress a little more, 
but at the cost of slower compression and decompression. 
Typically Method 2 will provide you with the best results when 
you’re compressing applications. 

• Method 3 (Best Size/Speed Trade Off): Method 3 provides the 
best trade off between compression/decompression speed and 
archive file size and works well on a variety of different file 
types. This compression method does a reversible sort on the 
data, which places like data closer together which makes it 
more compressible. Method 3 is used when the compression 
level is set to Medium in Menu Preferences, DropStuff, or 
StuffIt Deluxe.

• Method 4 (Best text Compression): Method 4 provides 
compression that is primarily optimized for text. This 
compression method works by “predicting” what the next byte 
will be based on previous data. For example, if it is predicting 
the byte following “t” and “h”, it will give high probabilities to 
“e”, and “a”.

• Method 5 (Choose Method by File Type): This compression 
method uses a combination of Method 3 and method 4 to 
achieve better results. If the file being compressed is a mostly 
text file, it uses method 4, otherwise it uses method 3.

• Method 6 (Choose Method by Analysis): This method breaks 
the file being compressed into bite size pieces and compresses 
each piece with methods 2 through 4. Whichever method 
produces the smallest output is used for that chunk of data. This 
makes it very slow but it generally produces the smallest 
possible files. Method 6 is used when the compression level is 
set to Optimal in DropStuff.

Levels generally set “how hard” each method tries to compress.

In the matching algorithms (method 1 & 2), levels 1-9 generally corre-
spond to Gzip's compression levels. The higher the number the harder it 
tries to find a match (more compression, but slower). Levels above 9 use a 
different, more exhaustive search for previous matches, which gets extra 
compression, but at the expense of speed. In the “prediction” algorithm, the 
level corresponds to how many previous bytes to use when making the pre-
diction.

Note: Not all the compression methods used by StuffIt X support 
setting compression levels. You cannot specify compression levels 
for methods 3 or 5.
StuffIt X Settings:
Levels and 
Extents
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Extents has a direct relationship to how much memory is used. In methods 
1 & 2, the extent sets how far back to look for a match. In method 4, extent 
sets how much memory to use for storing the prediction information.

StuffIt X archives can also be converted to ASCII text format. Three text 
encoding methods are available, Base64 (-L 1), Base 88 (-L 2) and Base 
222 (-L 3). The levels of available text encoding determine how much of 
the full ACSII character set will be used to encode the data.The more char-
acters used, the less size overhead will be imposed as a result of translating 
the binary data of the archive into text characters. When sending archives 
via E-mail, it is best to use Base64. This uses the fewest characters, but as a 
result is the most compatible. Base 222 is a good choice if files are being 
posted to a news group.

StuffIt X archives can be created with encryption. There are 4 compression 
methods supported:

1=RC4 - Supports up to 512bit key lengths. 
2=DES - Supports to 64bit key lengths
3=BlowFish - Supports up to 448bit key lengths
4=AES - Supports up to 256bit key lengths

StuffIt X archives can be created with Error Correction. Adding error cor-
rection code to an archive will increase its size, but its availability allows 
the engine to reconstruct data damaged as the result of bad media or trans-
fer errors during the decode phase. You can vary the amount of error cor-
rection code applied to an archive during the encode phase, the range of 
values supported are as follows:

• 1/4 of a block ( 1% Overhead)
• 1/8 of a block (3% Overhead)
• 1/16 of a block (6% Overhead)
• 1/32 of a block (14% Overhead)
• 1/64 of a block (33% Overhead)

Optimizer are special compression methods designed to handle specific file 
types. StuffIt Deluxe includes optimizer designed to compress Wave sound 
files, Tiff graphics, and text files.
StuffIt X Settings:
Text Encoding
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The Block Mode setting determines whether StuffIt will group files 
together in order to compress them more efficiently.

When creating StuffIt (.sit) archives you can choose between faster 
compression or smaller archive file sizes. You can also choose to use no 
compression at all when creating archives.

When you create Zip archives you can choose between two different 
compression methods, Deflate and Deflate 64. Typically, you will want to 
use the Deflate compression method as it is most compatible with other zip 
programs. Use Deflate 64 when you need to create zip archives that are 
more than 2Gb is size.

You can set the compression level for Zip compression between 1 and 15. 
At level 1 compression will be very fast, but the archives will be larger. At 
level 15 compression will be very slow, but the archives will be very small. 
Changing the compression level has no effect on the compatibility of the 
archive with other zip programs.

Lha Supports just two compression levels, 0 and 1. Level 1 produces 
smaller archives, but is slow than level 0.

You can set the compression level for Gzip compression between 1 and 15. 
At level 1 compression will be very fast, but the archives will be larger. At 
level 15 compression will be very slow, but the archives will be very small. 

You can set the compression level for Bzip2 compression between 1 and 9. 
At level 1 compression will be very fast, but the archives will be larger. At 
level 9 compression will be very slow, but the archives will be very small. 

You can set the compression level for UnixCompress compression between 
1 and 5. At level 1 compression will be very fast, but the archives will be 
larger. At level 5 compression will be very slow, but the archives will be 
very small. 
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Chapter 16: The StuffIt X Revolution
StuffIt X is a revolutionary new archive file format powered by Aladdin’s 
exclusive StuffIt compression technology. The new StuffIt X file format 
integrates compression with security and safety options to meet the 
requirements of business and today's digital lifestyle.

StuffIt X is name of the new format, and StuffIt X archives have a file 
extension of .sitx. You can use StuffIt X archives on any version of the Mac 
OS from 8.6 to 9.x, and any version of Mac OS X 10.1 or later. You can 
also use StuffIt X archives on Windows.

Whether you’re sending critical documents to business partners, or 
vacation pictures to your family, StuffIt X is your best solution. In addition 
to making the smallest possible archives, StuffIt X offers you strong 512bit 
encryption to protect your files should they fall into the wrong hands, and 
also features available error correction that helps to prevent data loss in the 
event that your archives become corrupt as a result of transfer errors or bad 
media. 

StuffIt X archives cannot be expanded by older versions of StuffIt Deluxe 
or StuffIt Expander. In order to expand a StuffIt X archive, your recipient 
must have a copy of at least StuffIt Expander 7.0 installed. To make your 
life easier, Aladdin provides StuffIt Expander for free to any Macintosh or 
PC user. If you the StuffIt Deluxe CD, you’ll find a copy of StuffIt 
Expander for Macintosh and Windows included. If you need a copy of 
StuffIt Expander, visit our website: http://www.stuffit.com/expander

The StuffIt X file format is designed to provide state of the industry 
compression. When you create archives using the StuffIt X file format you 
should expect to see upto a 20% improvement over the existing StuffIt 
(.sit) format, and upto a 40% improvement over Zip (.zip).

Note: The amount of compression you will see will vary depending 
on the type of data you are compressing. Typically text files com-
press the best, and files that contain already compressed data (such 
as MP3 music files or JPEG pictures) will not be compressed as 
well.

Even with Macintosh computers shipping with the minimum of a 10Gb 
hard drive, compression still has an important role to play in the general 
computing tasks that you perform everyday. Every time you download 
Overview
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send a file to someone over the Internet, you can save time by first 
compressing that file. The smaller the file, the more quickly it can be 
transferred. 

If you are hosting files for other people to download over the Internet the 
size of the file you provide is especially important. Most Internet Providers 
charge in such a way that the more kb of data users download from your 
site, the more money it will cost you to host. Even if you being charged a 
fixed fee to serve a small web site, your ISP has probably set a maximum 
bandwidth allowance that limits the number of Megabytes of data that can 
be downloaded from your site. Using StuffIt X to compress your files 
allows you to maximize your bandwidth without having to increase your 
cost.

While better compression is an important feature of the StuffIt X, what 
makes the format a significant leap forward are all the enhanced file 
security features that are also included.

• Strong Encryption: The StuffIt X file format provides 512 bit 
encryption to protect your sensitive data. This is a significant 
improvement over the 40 bit encryption offered by the StuffIt 
and Zip formats.

• Error Recovery: Users looking to protect their files against 
corruption can choose to create StuffIt X archives with error 
recovery. If your archives become corrupted as a result of 
The StuffIt X 
advantage
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transfer errors or bad media, StuffIt can recover the missing 
information.

• Support for large archive size: StuffIt and Zip archives are 
each subject to a file size limitation that prevents you from 
creating an archive larger than 2Gb in size. The StuffIt X file 
format has no such limitation, and will allow you to create 
archives that are up to terabytes in size.

• Support for long file names: StuffIt X archives 

The StuffIt X file format provides you with many choices when you 
compress your files. By default, when using Magic Menu, StuffIt 
Contextual Menu, StuffIt Deluxe, or Drop Stuff, you can choose between 
“Fast” or “Better” compression. One choice empathizes speed over archive 
size, the other archive size over speed. You can also choose a “Custom” 
compression setting that provides you with an increased level of control 
over exactly how StuffIt X archives are created.

See “Chapter 15: Expert Compression Settings” on page 88 for more 
details on setting StuffIt X compression options.

By default, StuffIt Deluxe is configured to use the older StuffIt (.sitx) 
format when creating archives, but we’ve also made it easy for you to 
change the compression method to StuffIt Deluxe.

• DropStuff: Open the DropStuff preferences dialog and click 
the Stuffing icon in the toolbar. From the Archive Type pop-up 
menu choose “StuffIt X”.

• Magic Menu and StuffIt Contextual Menu: Choose 
Preferences from either the StuffIt Contextual menu or the 
Magic Menu. Click the StuffIt icon in the toolbar, and choose 
“StuffIt X” from the StuffIt archive Format pop-up menu.

• StuffIt Deluxe: When you created a new archive using StuffIt 
Deluxe choose “StuffIt X” from the Archive Type pop-up 
menu.

To access the full range of options made available in the StuffIt X format, 
use the new StuffIt Command Line Tools. For more information, see 
“Chapter 14: Command Line Tools” on page 84
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Chapter 17: StuffIt Reference
The StuffIt Reference chapter is intended to provide more detailed infor-
mation about compression and archiving topics not directly connected to 
the operation of any of the StuffIt Deluxe applications. 

The StuffIt Deluxe application is able to create archives in the following 
formats:

• StuffIt (.sit)
• StuffIt X (.sitx)
• Zip (.zip)
• Tar (.tar)
• Lha (.lzh)

Note: StuffIt Deluxe is able to expand and create encrypted Zip 
archives, but does not currently support segmented or spanned Zip 
archives.

StuffIt Deluxe able to expand, but not create, these additional archive file 
formats:

• Arj (.arj)
• Arc (.arc)
• Compact Pro (.cpt)
• StuffIt 3.x archives (.sit)
• StuffIt 1.5.1 archives (.sit)
• Private File (.pf)
• Rar (.rar)
• CAB (.CAB)

Note: StuffIt Deluxe now supports expansion of RAR 3.0 archives.

StuffIt Deluxe is able to compress using the following “single file only” 
formats

• Gzip (.gzip)
• Bzip (.bzip)
• Unix Compress (.Z)
Overview
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StuffIt Deluxe is able to encode files using the following encoding meth-
ods:

• MacBinary (.bin)
• UUEncode (.uu)
• BinHex (.hqx)
• AppleSingle (.as)

StuffIt Deluxe is able to expand, but not create, the following encoding for-
mats:

• MIME/Base 64 (.mm, .mme, .b64)
• yEncode (.yenc)

Compression works by eliminating or minimizing redundancy in a file, 
making your files smaller without losing any information. Every character 
on your computer, every letter, digit and punctuation mark, is actually 
made up of several characters that make up computer code. A simple 
example of compression is: If you have a set of characters "AAAAD-
DDDDDD" representing a letter, one type of compression software can 
rewrite this as "4A7D", saving seven spaces and making that line 64% 
smaller. Compression software uses algorithms to do this.
Supported 
Encoding For-
mats

File Compression 
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